Toon Boom
Harmony V15.0

Paint Application Reference Book

TOON BOOM ANIMATION INC.

+1 514 278 8666

4200 Saint-Laurent, Suite 1020
Montreal, Quebec, Canada
H2W 2R2

contact@toonboom.com
toonboom.com

Harmony 15.0 Paint Reference Guide

Legal Notices
Toon Boom Animation Inc.
4200 Saint-Laurent, Suite 1020
Montreal, Quebec, Canada
H2W 2R2
Tel: +1 514 278 8666
Fax: +1 514 278 2666
toonboom.com
Disclaimer
The content of this guide is covered by a specific limited warranty and exclusions and limit of liability under the
applicable License Agreement as supplemented by the special terms and conditions for Adobe®Flash ® File
Format (SWF). For details, refer to the License Agreement and to those special terms and conditions.
The content of this guide is the property of Toon Boom Animation Inc. and is copyrighted.
Any reproduction in whole or in part is strictly prohibited.
Trademarks
Harmony is a trademark of Toon Boom Animation Inc.
Publication Date
01-15-2020
Copyright © 2018 Toon Boom Animation Inc., a Corus Entertainment Inc. company. All rights reserved.

1

Table of Contents

Table of Contents
Table of Contents

2

Reference

4

Chapter 1: Dialog Boxes

6

Advanced Save Dialog Box

7

Close Gaps Dialog Box

12

Configure Line Art to Colour Art Dialog Box

13

Create Palette Dialog Box

15

Database Selector Dialog Box

16

Onion Skin and Light Table Transparency Dialog Box

18

Palette Browser Dialog Box

19

Palette Operations Dialog Box

22

Preferences Dialog Box

24

Recolour Drawings Dialog Box

25

Remove Dirt Dialog Box

27

Remove Hair Dialog Box

28

Tint Offset/Blend Dialog Box

29

Toolbar Manager Dialog Box

31

Chapter 2: Tools Properties

32

Brush Tool Properties

34

Centerline Editor Tool Properties

54

Close Gap Tool Properties

56

Contour Editor Tool Properties

57

Cutter Tool Properties

60

Drawing Pivot Tool Properties

63

Dropper Tool Properties

65

Ellipse Tool Properties

66

Envelope Tool Properties

73

Eraser Tool Properties

76

2

Harmony 15.0 Paint Reference Guide

Ink Tool Properties

92

Line Tool Properties

94

Paint Tool Properties

102

Pencil Tool Properties

106

Pencil Editor Tool Properties

116

Perspective Tool Properties

122

Polyline Tool Properties

124

Rectangle Tool Properties

131

Reposition All Drawings Tool Properties

138

Select Tool Properties

140

Smooth Editor Tool Properties

149

Stroke Tool Properties

151

Text Tool Properties

153

Zoom Tool Properties

156

Chapter 3: Toolbars

158

Top Toolbars

159

Edit Toolbar

160

File Toolbar

161

Tool Presets Toolbar

162

Tools Toolbar

163

Workspace Toolbar

168

View Toolbars

169

Chapter 4: Views

170

Colour View

171

Drawing View

178

Integrated Help View

181

Message Log View

182

Model View

183

Tool Properties View

184

3

Reference

Reference
Harmony has several commands, dialog boxes, and buttons. The Reference section lists all of them along with
the matching definition. To understand how to use these functions in a production context, read the User
guide.
In the Reference guide, you will learn about the various parameters available in dialog boxes, menus, nodes,
toolbars, views, and windows.
The Preferences guide provides additional details about each individual preference.
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Chapter 1: Dialog Boxes

Chapter 1: Dialog Boxes
Dialog boxes contain controls such as options and lists through which you can carry out a particular command
or task. For example, in the Scene Settings dialog box, you must indicate the resolution and alignment. A typical
dialog box looks as follows:
Advanced Save Dialog Box
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Advanced Save Dialog Box
In Harmony Server, the Advanced Save dialog box lets you save the scene as a new version, overwrite an
existing version, set a new current version, display a list of modified drawings, colour palettes, and modified
colour palette lists.

How to access the Advanced Save dialog Box
1. From the top menu, select File > Save....
The Advanced Save dialog appears.
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File Tab

Parameter

Description

‣

Enable this option if you want to save the modifications made to the
current scene.

Save

‣

Deselect the Save option if you only want to save specific components of
your scene listed in the Drawings, Palettes or Palette Lists tabs. This will
disable all option in the File tab.

This Version (number)

Saves the current version of the scene. You can rename the current version by
typing a new name into the field.

New Version (number)

Saves the current scene as a new version. You can name this new version by
typing a name into the field.

Overwrite Existing Version

Lets you select an existing version of your scene from the list to overwrite it.

Description

Use this field to add or edit an existing description for the scene version you want
to save.

Mark as Current

Lets you set this scene version as the current one. This version will be
automatically selected as the default current version when the scene is selected in
the Database Selector dialog box
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Drawings (Harmony Server only)
The Drawings tab lists the modified drawings.

Parameter

Description

Drawing list

Lets you select the modified drawings to save, and deselect the ones you do not
want to save.

Select All

Selects all modified drawings in list.

Deselect All

Deselects all modified drawings in the list.

Palettes Tab
The Palette tab lists the modified colour palettes.
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Parameter

Description

Colour Palette list

Lets you select the colour palette to save, and deselect the ones you do not want
to save.

Show Recovered

Displays the recovered palettes in the list of modified palettes.

Select All

Selects all modified colour palettes in the palette list.

Deselect All

Deselects all modified colour palettes in the palette list.

Palette Lists Tab
The Palette Lists tab lists all the modified colour palette lists.
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Parameter

Description

Palette Lists

Lets you select the modified palette list to save, and deselect the ones you do not
want to save.

Show Recovered

Displays the recovered palettes in the list of modified palettes.

Select All

Selects all modified palette lists in the list.

Deselect All

Deselects all modified palette lists in the list.
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Close Gaps Dialog Box
The Close Gaps dialog box lets you close up drawing areas that not are closed. This may sometimes happen
when painting. You can close small gaps in a drawing by creating small, invisible strokes between the two
closest points to close the colour zone. You do not need to trace directly over the gap. You can draw it a few
millimeters away. The two closest points automatically close the gap.

How to access the Close Gaps dialog box
1. Select View >Show Strokes or press K to see a preview of the result.
2. To flatten the strokes you draw, click the Auto-Flatten

button in the Tool Properties view.

3. Select Drawing > Close Gaps or press Shift + F10 (Windows/Linux only).
The Close Gaps dialog box opens.

Parameter

Description

Size

Lets you set the size of the gap you want to be closed.

Apply to all drawings

Closes all gaps in the drawing of the selected layer.
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Configure Line Art to Colour Art Dialog Box
The Configure Line Art to Colour Art dialog box lets you modify settings for the Line Art and Colour Art layers.

How to access the Configure Line Art to Colour Art dialog box
1. In the Tools toolbar, select the Select tool.
2. In the Tool Properties view, hold down the Shift key and click on the Creatre Colour Art from Line
Art button.

Parameter

Description

Use rendered version of the
drawing

Renders the drawing and vectorize it to calculate the position of the centreline
that will produce the colour art stroke.

Maximum Resolution for
rendered image

The size of the rendered image.

Threshold for rendered image

The value of grey processed to create the rendered vectorized arts.

Fitting error for rendered
Beziers

This value represents how precise the fitting of the colour art zone in relation to
the line art will be.

Source layer

Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the
colour art to be created from.

Destination layer

Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the
colour art to be created on.

Clear Destination Art Layer

Deletes the content before the colour art is added. This is useful when you
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First

already have artwork on the destination layer.

Perform Line Art to Colour
Art Operation Immediately

Performs the Create Colour Art from Line Art command when you click OK.
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Create Palette Dialog Box
The Create Palette dialog box allows you to create a colour palette for your scene. Palettes created with this
dialog box are added to your scene's palette list, and stored in your scene's palette-library subdirectory.
The Create Palette dialog box is used by default to create palettes. If you have the Advanced Palette Lists
preference enabled, the Palette Browser dialog will open instead, which allows you to decide the level of
palette list and storage desired for your palette—see Palette Browser Dialog Box.

How to access the Create Palette dialog box
1. Do one of the following:
l

In the Colour View, click the New Palette

button over the palette list.

l

From the Colour view menu, select Palettes > New

Parameter

Description

New Palette Name

Lets you enter a name for the new palette.
Lets you choose one of the following palette types:
l

Palette Type
l

Colour: A colour palette can contain colours, gradients and bitmap textures.
Pencil Texture: A pencil texture palette can contain textures to apply as
transparency filters to pencil lines, in combination to their line colour, to create
various styles of pencil lines.
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Database Selector Dialog Box
The Database Selector dialog box lets you connect to your studio's central database when working on
Harmony Server.
NOTE
When you connect to the database, you cannot create new scenes directly from Harmony. The
available scenes must have been already created using the Control Center module.

How to access the Database Selector dialog box
1. Start Harmony Paint
2. In the User Name field, type in your Harmony Server username.
3. Click on OK.
The Database Selector dialog box opens.

Parameter

Description

Environments

Lets you select the scene's environment (project, movie).

Jobs

Lets you select the scene's job (episode, sequence).
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Scenes

Lets you select the scene.

Get rights to modify the
scene

Allows you to modify the selected version of the scene as well as to manage and
overwrite other versions. Other users will not be able to open a different version
of the scene until you close the scene.

Get rights to modify the
scene version

Allows you to modify the currently selected scene version only. Unless the Get
rights to modify the scene option is also checked, you will not be able to change
other versions of the scene. This allows other users to modify different versions
of the scene while you are working on the selected version.

Get rights to modify all scene
assets

Automatically gets the rights to modify all of the scene's assets, locking other
users from making changes to them until you close the scene. This means that
you will have the rights to modify all the scene's versions, drawings, palettes, its
palette list, but not its library folder. If this option is unchecked, drawings and
palettes will be locked unless you unlock them manually. This can allow another
user to work on the scene's drawings and palettes in Harmony Paint while you
are working on the scene's timing or staging in Harmony.

Version

If you saved different versions of a scene, this lets you select one to open.
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Onion Skin and Light Table Transparency Dialog Box
T-ANIMPA-006-009
This dialog box lets you adjust the Onion Skin and Light table transparency parameters.

How to access the Onion Skin and Light Table Transparency dialog box
l

In the Drawing view toolbar, click on the Top Light

button to open the Onion Skin and Light

Table Transparency dialog box.

Command

Description

Onion Skin Opacity

Sets the maximum opacity value for the onion skin opacity display. Moving the
slider all the way to the left = 0% opacity. Moving the slider all the way to the
right = 100% opacity.

Lighttable Opacity

Sets the maximum opacity value for the light table display. Moving the slider all
the way to the left = 0% opacity. Moving the slider all the way to the right =
100% opacity.

LightTable Wash

Sets the washed-out value for the light table display. Moving the slider all the
way to the left = 0% opacity. Moving the slider all the way to the right = 100%
opacity.

Bitmap Background
Wash

Sets the maximum opacity value for the background wash. Moving the slider all
the way to the left = 0% opacity. Moving the slider all the way to the right =
100% opacity. Only works for bitmap layers.

Pencil Lines Opacity

Sets the maximum opacity value for central vector lines (lines made by the
Pencil or Shape tools). Moving the slider all the way to the left = 0% opacity.
Moving the slider all the way to the right = 100% opacity.
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Palette Browser Dialog Box
The Palette Browser dialog allows you to decide the level of palette list and palette storage to use when you
want to create, clone, link to or import a palette.
This dialog only appears if you have the Advanced Palette Lists preference enabled, which is disabled by
default. When Advanced Palette Lists mode is disabled, Harmony automatically stores palettes in a scene's
palette list, inside the scene's palette-library subdirectory.

How to access the Palette Browser dialog box
1. Start Harmony Paint and log in.
2. Close the Database Selector dialog box.
3. From the top menu, select Tools > Palette Operations.
1. In the Palette Operations dialog box that opens, select the palette you want to clone at the location and
level in which it was stored.
2. Click Clone.
Parameter

Palette Location

Description
This allows you to browse for the physical location of the palette file in your
database.
If you are using Harmony Stand Alone, you can still select the scene's own job or
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environment as a location. Stand alone scenes have a provisional job and
environment storage space inside the scene's directory. The files in these storage
spaces can be imported into a database scene's actual job and environment when
importing the scene to a Harmony database. If you never intend to use Harmony
Server, you should keep your palettes inside your scene or element's palette
libraries.
Stores the palette file in the selected environment's palette library. Environments
are typically used to contain a whole production, series or feature film.
Environment

l

l

In Harmony Server, this stores the palette in /USA_DB/environments/
[environment name]/palette-library.
In Harmony Stand Alone, this stores the palette inside the scene's
directory, under environments/Digital/palette-library.

Stores the palette file in the selected job's palette library. Jobs are typically used to
contain episodes in a series, or any set of scenes that is intended to be put in the
same sequence.
Job
l

l

In Harmony Server /USA_DB/jobs/[job name]/palette-library.
In Harmony Stand Alone, this stores the palette inside the scene's
directory, under jobs/Digital/palette-library.

Scene

Stores the palette file in the selected scene's palette library, which is the
palette-library subdirectory of the scene's directory.

Element

Stores the palette file inside the selected element's palette library. This library is
located inside the scene's directory, under elements/[element
name]/palette-library.

Palette

This lists the existing palettes in the selected location.

New Palette Name

If you are creating or cloning a palette, use this field to enter the palette file's
name. The palette will be listed under this name in your palette list. On your file
system, it will be named after its palette name, followed by the extension .plt.
When creating a palette, you can choose between the following palette types:
l

Palette Type
l

Colour: A colour palette can contain colours, gradients and bitmap
textures.
Pencil Texture: A pencil texture palette can contain textures to apply as
transparency filters to pencil lines, in combination to their line colour, to
create various styles of pencil lines.
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Palette List

Scene Palette List

This allows you to decide if you want the palette to be added to your scene's
palette list, or to the currently selected element's palette list.
Adds the palette to the scene's palette list. Palettes in the scene's palette list are
available to all the elements in your scene. This is especially useful if you are
doing digital animation, where character models can be made of many layers that
need to use the same palette.
Adds the palette to the currently selected element's palette list. Palettes in an

Element Palette List

element's palette list can only be used by the drawings in this element, and will
only be listed in the Colour view when this element is selected. This can be useful
if you are doing traditional animation, where each character is usually drawn on a
single layer, and you want each layer to have its own palette.
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Palette Operations Dialog Box
When you start Toon Boom Harmony connected to the database, you can access the Palette Operations dialog
box which lets you clone, rename, or delete palettes in your database, without having to open a scene or
browse the database's file system in your operating system's shell.
In Harmony, palettes are individual *.plt files that can be copied, transferred and stored. When a palette is
created from Harmony, it needs to be stored somewhere. By default, the palette file is stored in the scene
directory in a palette-library folder unless you specify a different location.
There are four locations where you can find palette-library folders: Element, Scene, Job and Environment.

How to access the Palette Operations dialog box
1. Start Harmony Paint and log in.
2. Close the Database Selector dialog box.
3. From the top menu, select Tools > Palette Operations.

Parameter

Description

Environment

The production, project, feature film or series.

Job

The episode and sequence from each environment.

Scene

The scenes from each job.

Element

The layers and columns in each scene.

Palette

The scene palettes.
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Description

Notes, if any, of the project.

Clone

Opens the Palette Browser dialog box from which you can select the level in
which to store the palette file.

Rename

Lets you rename a palette.
Lets you delete a palette.

Delete

NOTE
It is not recommended to disable the warning message that appears when
you are attempting to delete a palette as this operation cannot be undone.

Close

Closes the Palette Operations dialog box.
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Preferences Dialog Box
The Preferences dialog box lets you adjust preferences to suit your work style, allowing you to work more
efficiently.
NOTE
To learn more about the individual preferences, refer to the Preferences guide.

NOTE
Some preferences require you to exit and restart the application, or close a view and reopen it.

How to access the Preferences dialog box
Do one of the following:
l

Select Edit > Preferences (Windows/Linux) or Harmony [Edition] > Preferences (macOS).

l

Press Ctrl + U (Windows/Linux) or ⌘ + U (macOS).
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Recolour Drawings Dialog Box
The Recolour Drawing dialog box allows you to replace all instances of a colour or texture in drawings with a
different colour or texture swatch in one of the scene's palettes. This replaces the colours or textures in the
drawings without requiring you to modify the palettes. You can use this dialog to perform colour replacement in
the current drawing, in all the drawings in one or several layers or in all drawings in your scene.
This dialog will replace the colour or texture that is currently selected in the Colour view with the colour or
texture that you select inside the dialog.

How to access the Recolour Drawings dialog
1. In the Colour view, select the colour or texture swatch you want to replace by doing one of the
following:
l

Select the palette in which the colour or texture swatch is located, then select the swatch you
wish to replace.

l

If the drawing in the Camera or Drawing view contains the colour or texture you want to
replace, select the Dropper

tool in the Tools toolbar, then click on that colour or texture in

the drawing. The Colour view will automatically select that colour or texture's palette as well
as that colour or texture's swatch.
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2. Do one of the following:
l

Right-click on the swatches list, then select Recolour Drawings.

l

Open the Colour view menu

Parameter

, then select Colours > Recolour Drawings.

Description
Allows you to select which drawings will be affected by the colour replacement:
l

l

Replace Colour In

Current drawing: Replaces the selected colour in the currently selected
drawing only.
All drawings in the currently selected layers: Replaces the selected colour
in all the drawings in the layer that is currently selected in the Timelime or
Xsheet view.

NOTE
This option can work with several drawing layers selected.

l

Replacement Colour

All drawings in the scene: Replaces the selected colour in every drawing
in the current scene.

Allows you to select the palette and colour or texture swatch to replace the
selected colour or texture with.
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Remove Dirt Dialog Box
The Remove Dirt dialog box lets you select small dots and hairs on a drawing for removal.

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them.
These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Dirt dialog box
1. Do one of the following:
l

From the top menu, select Drawing > Remove Dirt.

l

Press Shift + D.

Parameter

Description
Lets you adjust the amount of detail removed from the layer.

Slider

Raising the Remove Dirt level will select bigger dots. When selecting larger dots,
be careful not to lose small details like pupils and nostrils. Once you have chosen
the level, you can apply it to the current drawing or the entire animation sequence.
This is a quick way to get rid of most dirt and dust.
During this process, the dirt that will be removed is highlighted in red.

Apply to all drawings

Applies the operation to all drawings in the layer.
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Remove Hair Dialog Box
The Remove Hair dialog box lets you remove any small strokes created in the Colour Art layer from very thick
lines or filled zones. Increasing the Remove Hair level value will select larger strokes for removal from the
drawing.

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them.
These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Hair dialog box
1. Select the drawing containing the drawing to clean.
2. From the top menu, select View > Show Strokes to display the invisible lines or press K.
3. In the top menu, select Drawing > Remove Hair.

Parameter

Description

Slider

Lets you adjust the number of length of hairs selected.

Apply to all drawings

Applies the operation to all drawings in the layer.
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Tint Offset/Blend Dialog Box
You can offset, blend, or mix the colours in a colour palette using the sliders and increasing the Amount value.

How to access the Tint Offset/Blend dialog box
1. From the Colour View menu, select Palettes > Tint Panel or right-click and select Tint Panel.
The Blend/Offset Tint panel opens.

Parameter

Description

Offset

Offsets the selected colours by the adjustments made using the HSB and RGB
sliders. Use the Amount slider to adjust the degree of offset. Use the Alpha slider
to adjust the opacity of the selected colour.

Blend

Blends the selected colours with the colour swatch in the top-right corner. Use
the Amount slider to adjust the degree of blend. A blend of 100% turns the
selected colours into the same colour as the swatch. Adjusting the HSB and RGB
sliders affect the swatch colour, which in turn affects the selected colours on the
left. Use the Alpha slider to adjust the opacity of the swatch.

Mixer

Select a Base and Tint colour to form a third colour swatch. Use the slider just
beneath to mix the Base and Tint colours by different amounts. This will affect the
mixed swatch whether it is selected or not. Select either the Tint or Base swatch
and use the HSB and RGB sliders to adjust its colour. This will affect the mixed
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swatch colour, which in turn affects the selected colours on the left.
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Toolbar Manager Dialog Box
The Toolbar Manager dialog box lets you customize the toolbar in any of the views. You can add your favourite
tools to a toolbar for an efficient workflow.

How to access the Toolbar Manager dialog box
1. Right-click on a toolbar in any view and select Customize. Note that the menu will not appear if you
right-click on a disabled icon.

Parameter

Description

Available Tools

Displays the complete list of tools available for customizing a toolbar.

Toolbar

Displays a list of the tools currently available on the toolbar.

Default

Restores the toolbar with its default items.
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Chapter 2: Tools Properties
Harmony has a wide variety of drawing and manipulation tools and each one of them has a series of options
and modes available in the Tool Properties view. This section covers these options.

Brush Tool Properties

34

Centerline Editor Tool Properties

54

Close Gap Tool Properties

56

Contour Editor Tool Properties

57

Cutter Tool Properties

60

Drawing Pivot Tool Properties

63

Dropper Tool Properties

65

Ellipse Tool Properties

66

Envelope Tool Properties

73

Eraser Tool Properties

76

Ink Tool Properties

92

Line Tool Properties

94

Paint Tool Properties

102

Pencil Tool Properties
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Pencil Editor Tool Properties
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Perspective Tool Properties
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Polyline Tool Properties
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Rectangle Tool Properties
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Reposition All Drawings Tool Properties

138
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Select Tool Properties

140

Smooth Editor Tool Properties

149

Stroke Tool Properties

151

Text Tool Properties

153

Zoom Tool Properties

156
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Brush Tool Properties
When you select the Brush

tool, its properties and options appears in the Tool Properties view.

Brush Properties
The following properties affect the brush's size, smoothing and other properties for the drawing style of your
brush. Those properties can be saved into brush presets for later use.
Icon

Property

Description
The Preview area lets you see a preview of the stroke your drawing tool
will make.

Preview Area

The arrow button right of the preview area opens the Brush Properties
dialog.
Brush Properties Dialog
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While the Tool Properties view only gives you access to a few of the
brush properties, a list of brush presets and other drawing options, the
Brush Properties dialog gives you access to all the available options for
your brush's tip and texture. For more information on
the Pencil Properties dialog, see the Brush Properties Dialogsection
below.
Defines the maximum width of brush strokes.
Maximum Size

If the tool is used with a pressure sensitive pen tablet, the width of the
stroke will vary between its maximum size and minimum size depending
on the amount of pressure used. If used with a mouse, the width of the
stroke will always be its maximum size.
Defines the number of control points added to the centre line. The fewer
the control points the smoother (but less faithful) the line.

Smoothing

NOTE
This option is only available when drawing on a vector layer.

Lets you set the opacity for each instance of the brush tip that gets printed
into your canvas. Contrary to the Opacity parameter, the flow parameter

Flow

has a cumulative effect. This means that a lower flow will make your brush
strokes more transparent towards its extremities and more opaque in its
center. Your stroke's flow will also accumulate if you draw over it. By
default, your brush's flow varies with the amount of pressure you put on
your tablet pen.

NOTE
This option is only displayed in the Tool Properties view when
drawing on a bitmap layer.

Opacity

The Opacity parameter are where Lets you set the opacity of your brush
strokes. Contrary to the Flow parameter, the Opacity parameter is noncumulative. Your whole brush stroke's opacity will not exceed the Opacity
parameter. By default, the Opacity parameter varies depending on the
amount of pressure you put on your tablet pen.

NOTE
This option is only displayed in the Tool Properties view when
drawing on a bitmap layer.
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Brush Presets
These options allow you to select, create and manage pencil presets.
Icon

Property

Description
By default, Harmony has preloaded brush presets. You can also create
your own brush presets by configuring your brush, then saving its
properties into a new preset. It is also possible to export and import brush
presets.

Presets list

New Brush Preset

Creates a new preset based on the current brush properties.

Creates a dynamic brush preset based on the selected drawing. A
dynamic brush is a drawing that you can paint or stamp.

New Dynamic Brush

NOTE
You can also create a dynamic brush preset that cycles through
several drawings. To do this, create the drawings on several
layers, then select them all using the Select tool in the Camera
view, with the Single mode option disabled.

Delete Brush

Deletes the currently selected preset.

Rename Brush

Deletes the currently selected preset.

Import Brushes

Allows you to import brush presets exported from Harmony.

Export Brushes

Allows you to export your brush presets into an .xml file.

Small Thumbnail

Displays presets in a grid of small thumbnails with a preview of their tip.
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Large Thumbnail

Displays presets in a grid of big thumbnails, with their name and a
preview of their tip.

Stroke View

Displays presets in a list, with their name and a preview of a stroke done
with each preset. This is the default setting.

Drawing Options
These options affect the way your drawing strokes are integrated into your artwork.
Icon

Property

Description
When enabled, your brush strokes will appear behind the existing
artwork. Note that they will appear over your artwork while drawing your
stroke, until you release the brush.

Draw Behind

When enabled, your brush strokes will only repaint existing artwork and
will not add colour to empty areas. If you repaint semi-transparent
artwork, your artwork will not become more opaque than it already is.
Repaint Brush

As you draw in the Line Art layer, the Automatically Create Colour Art
option instantly creates the corresponding strokes in the Colour Art layer.

Automatically Create
Colour Art

NOTE
This option is only available when drawing on a vector layer.
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By default, when drawing, each new stroke is created as a separate
drawing object, which can be edited independently from other parts of
the artwork. When enabled, the Auto-Flatten option automatically merges
strokes into existing artwork.
Auto-Flatten Mode

NOTE
This option is only available when drawing on a vector layer.
When drawing on a bitmap layer, artwork is always flattened.

In the Colour view, it is possible to make some of the colours in your
palettes protected from change. When enabled, the Respect Protected
Colour option will prevent the brush tool from drawing over areas filled
with a protected colour.
Respect Protected
Colour

NOTE
This option is only available when drawing on a vector layer.
When drawing on a bitmap layer, colour is not linked to your
palettes and cannot be protected.

The Use Stored Colour Gradient option can be used when painting with a
gradient colour to always position the gradient in the same way it was

Use Stored Colour
Gradient

stored, making it consistent across brush strokes. You can store a
gradient by selecting a zone painted with a gradient with the Select tool,
then clicking on Store Colour Gradient

in the Tool Properties view.

NOTE
This option is only available when drawing on a vector layer.

Brush Properties Dialog
Brushes have an extensive set of options and properties that are not displayed in the Tool Properties view, but
rather, in a dialog you can access from it. To open the Brush Properties dialog, click on the arrow button right of
the stroke display area.

The Brush Properties dialog has five different tabs, minus the Smoothing tab if you are working on a bitmap
layers. Below is detailed information about the options available in each tab:
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l

Tip Tab on page 39

l

Smoothing Tab on page 44

l

Transparency Tab on page 45

l

Dual Tip Tab on page 48

l

Paper Texture Tab on page 51

Tip Tab
The Tip tab allows you to configure the shape, size, hardness and spacing of your brush tip.
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Property

Description
Allows you to select between one of the following brush types:
l

Brush Type

Solid Vector Brush: Creates vector shapes filled with a solid colour.
Makes artwork lightweight, scalable and easy to tweak. Since this kind of
brush can only create solid colour shapes, solid vector brushes have a
limited set of options including size, roundness, angle, centerline
smoothing and contour smoothing.
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l

Textured Vector Brush: Creates vector shapes filled with a texture. This
gives you access to bitmap brush tips, paper textures, transparency and
several other options.

NOTE
This option is not available when working on a bitmap layer. With bitmap
layers, brushes are always textured, and textured brush options are
always available.

Brush Tip Library

This is where you select the shape of the brush tip. By default it is round. Note
that some tips are designed to have semitransparent areas, even when the
maximum brush opacity is set to 100%.
To create a custom brush tip, you must prepare the file ahead of time, either in
Harmony or in a third-party software, such as Adobe Photoshop. Colour is not
supported and transparency is not supported in the traditional sense. Black
appears as 100% opaque, white appears as 100% transparent and all the shades
of grey in between appear as varying degrees of semitransparency. A range of file
formats are supported—.jpeg, .png, .tif, .psd, .tga to name a few. Alpha channels
are disregarded on import. It is recommended that your file be between 100 x
100 pixels and 400 x 400 pixels.
You can also import brush tips that you exported from Harmony, so you can
share them with colleagues.
The minimum and maximum sizes of your drawing tool produce the thick and
thin effect on your stroke. This works with the pressure sensitivity of a pen
tablet.
l

l

Minimum and Maximum Size

Maximum Size: Defines the maximum width of the stroke.
Minimum Size: Defines the minimum width of the stroke in relation to
and as a percentage of the maximum size.

NOTE
Setting the Minimum Size value to 100% eliminates the possibility of
creating width variation on your stroke. In other words, you would be
forcing a uniform line width using the Maximum Size value.
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The Roundness and Angle parameters allow you to change the shape and
orientation of the tip.
l

Roundness and Angle
l

Roundness: Squashes the height of the tip from its centre point. 100%
roundness = the native height of the tip. A smaller percentage will make
the brush tip look flatter and more narrow. The squashing is NOT relative
to the angle value—if the tip is rotated, the squashing function still uses
the brush tip's original orientation.
Angle: Rotates the brush tip counter-clockwise. 0° = the tip's native
orientation.

The Hardness and Spacing parameters allow you to change the softness and
spacing of the marks made by the brush tip. You can preview the hardness and
spacing at the top of the Brush Properties window, stroke preview area.

Hardness

The hardness value corresponds to the softness of the brush tip's edges. The
lower the value, the softer the tip edge. The higher the value, the sharper the tip
edge. Be aware that some brush tips are not 100% opaque, so they will always
appear somewhat soft, even at 100% hardness.

Defines the amount of space between each stamp of the brush. A value of 100%
sets the stamp marks edge to edge, if there is no white space around the shape.
The larger the value, the greater the space between marks. A really large value
can make the brush stroke appear as a string of individual marks. Conversely, a
small spacing value will give the appearance of a fluid brush stroke.
Spacing is only evident when making a continuous stroke.
Spacing
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Randomness

The Randomness parameters let you create a varied brush stroke. Refining these
options can give your stroke a lovely, non-mechanical look.
You can create variation between the thick and thin of your brush stroke just by
setting the Maximum and Minimum Size values. If you add randomness to the
mix, pressure sensitivity from your drawing tablet will still be applied. Light
pressure will create random values around the minimum, while heavy pressure
will create random values closer to the maximum. The larger the percentage, the
larger the range of random variation.

Random Size

NOTE
Setting the Minimum Size to 100% eliminates the possibility of creating
width variation on your stroke, whether you are applying randomness or
not. Therefore, you would be forcing a uniform line width using the
Maximum Size value.

Sets the range for random rotation around the set Angle value. For example, if
the Angle is set to 45° and the Random Angle set to 10°, the software will
choose values between 40°–50° (plus or minus 5 degrees, equaling a total of 10
degrees).

Random Angle

Random Spacing

Sets the range for random spacing around the set Spacing value. For example, if
the Spacing is set to 50% and the Random Spacing is set to 10%, then Harmony
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will choose values between 45%–55% (plus or minus 5 percent, equaling a total
of 10 percent).

Smoothing Tab
The Smoothing tab contains options to configure how Harmony should automatically smooth your brush
strokes as you paint.

NOTE
The Smoothing tab is only available when working on a vector layer, as bitmap layers do not
support smoothing.

Property

Description

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on your brush stroke's
direction, curves and corners. A higher setting will prevent your line from being
shaky, but is liable to reduce drawing precision and turn sharp angles into curves.
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Contour Smoothing

Defines the amount of smoothing Harmony should perform on outer contour of the
brush stroke. A higher setting will round sharp corners and reduce the amount of
control points for the resulting vector shape.

Transparency Tab
The Transparency tab allows you to decide if your brush has antialiasing as well as to set its flow and opacity
settings.

NOTE
The Transparency tab's options are only available on vector layers if the Brush Type option of the
Tip tab is set to Textured Vector Brush. On bitmap layers, those options are always available.

Property

Description
Enabled by default. This option causes the contours of the brush strokes to
blend with the surrounding colours, to create an illusion of smoothness
otherwise not possible due to the picture resolution.

Antialiasing

If antialiasing is disabled, the brush's texture will only render fully transparent or
fully opaque pixels. Disabling this option can be useful if you need your outlines
to be very crisp, if you want to make pixel art or if you need your brush strokes to
render in solid colors with no variation, which makes them easier to repaint or
process in third party software.

NOTE
When disabled, all other options in the Transparency tab are disabled.
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The Maximum and Minimum Flow parameters let you set the range for the rate at
which paint flows from your brush. The analogy works better with a pen. The
greater the flow, the more ink comes out, hence the more consistent the colour
and texture of the line. If the flow is light, then the colour and texture of the line
may look spotty. This feature works with the pressure sensitivity of a pen tablet.
l

l

Maximum and Minimum Flow

Maximum Flow: Sets the maximum rate at which colour and texture are
applied as you create a fluid stroke.
Minimum Flow: Sets the minimum rate at which colour and texture are
applied as you create a fluid stroke. It is defined as a percentage of the
Maximum Flow value. If the Minimum Flow value is set to 100%, then
tablet pressure sensitivity will no longer be applicable. The flow will be
set to the constant rate of the Maximum Flow value.

The Maximum and Minimum Opacity parameters are where you set the opacity
range for a brush mark. This works with the pressure sensitivity of a pen tablet.
l

l

Maximum Opacity and
Minimum Opacity

Randomness

Maximum Opacity: Sets the transparency limit of the brush mark when
the pressure is heavy.
Minimum Opacity: Sets the transparency limit of the brush mark when the
pressure is very light. It is defined as a percentage of the Maximum
Opacity value. If the Minimum Opacity value is set to 100%, then tablet
pressure sensitivity will no longer be applicable. The opacity will be set to
the constant rate of the Maximum Opacity value.

Th Randomness parameter lets you set the range for the randomness of the flow
and opacity. This works with the pressure sensitivity of a pen tablet.
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You can create variation in the flow of your brush stroke just by setting the
Maximum and Minimum Flow values. If you add randomness to the mix, pressure
sensitivity from your drawing tablet will still be applied. Light pressure will create
random values around the minimum, while heavy pressure will create random
values closer to the maximum. The larger the percentage, the larger the range of
random variation.

Randomness Flow

NOTE
Setting the Minimum Flow value to 100% eliminates the possibility of
creating flow variation on your stroke, whether you are applying
randomness or not. That is, you would be forcing a uniform flow using the
Maximum Flow value.

Random Opacity

You can create variation in the opacity of your brush stroke just by setting the
Maximum and Minimum Opacity values. If you add randomness to the mix,
pressure sensitivity from your drawing tablet will still be applied. Light pressure
will create random values around the minimum, while heavy pressure will create
random values closer to the maximum. The larger the percentage, the larger the
range of random variation.
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NOTE
Setting the Minimum Opacity value to 100% eliminates the possibility of
creating opacity variation on your stroke, whether you are applying
randomness or not. That is, you would be forcing a uniform opacity using
the Maximum Opacity value.

Dual Tip Tab
The Dual Tip tab lets you set the parameters for creating a dual tip brush. The primary bitmap brush tip and the
dual tip always work together. You can set the parameters for the primary tip in the Tip tab and those for the
dual tip in the Dual Tip tab. The Blend mode you select determines how the tips are combined.
By default, the Blend Mode is set to Multiply and the Random Angle to 360°.
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NOTE
To use a Dual Tip, you must enable option by checking the checkbox inside the Dual Tip tab.
Additionally, if you are working on a vector layer, the Brush Type option of the Tip tab must be set
to Textured Vector Brush.

Property

Description

Enable/Disable

The checkbox inside the tab allows you to decide whether or not your brush uses a
dual tip. If this checkbox is unchecked, the options in the Dual Tip tab will be
disabled.

Blend Mode

The Blend modes let you decide how the primary tip and the dual tip are combined.

Multiply

This is the default blend mode. When the two brush tips are combined in this mode,
they essentially cut each other out in overlapping areas, where one or both tips have
an area of 100% transparency. The less opaque the brush tips are, the lighter their
combination.
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In this mode, the primary tip cuts out the shape of the dual tip. Where the tip shapes
overlap, within the boundaries of the primary shape, the colour and opacity appear
darker.

Colour Dodge
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This mode treats the two tips as two different and separate brushes that have the
same colour and follow the same path.

Combine

Paper Texture Tab
The Paper Texture tab lets you configure a paper-like texture for your brush. You can also add textures by
importing image files, or import paper textures that were previously exported from Harmony.
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NOTE
To use a Paper Texture, you must enable option by checking the checkbox inside the Paper
Texture tab. Additionally, if you are working on a vector layer, the Brush Type option of the Tip tab
must be set to Textured Vector Brush.

Property

Description

Enable/Disable

The checkbox inside the tab allows you to decide whether or not your brush uses a
paper texture. If this checkbox is unchecked, the options in the Paper Texture tab will
be disabled.

Texture Scale

Increase or decreases the size of the paper texture.

Additive

This option layers the texture on top of itself as you scribble overlapping lines in one
continuous stroke. If this option is turned off, areas of overlapping lines from a single,
continuous stroke will appear the same, in terms of darkness and texture, as nonoverlapping areas.
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This option defines the way separate, overlapping strokes behave. If this option is
enabled, the paper texture's position does not change with each sweep of the brush.
If this option is disabled, each sweep of the brush produces a different texture
position. The texture orientation always stays the same.

Aligned
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Centerline Editor Tool Properties
When you select the Centerline Editor tool, its properties and options appear in the Tool Properties view.

Tool Options
Icon

Property

Description
Sets the selection mode to Lasso, which allows you to select
multiple items by drawing a lasso around them.

Lasso

TIP
When this option is enabled, you can press and hold the
Alt key to temporarily use Marquee mode.

Sets the selection mode to Marquee, which allows you to select
multiple items by drawing a rectangle around them.
Marquee

TIP
When this option is enabled, you can press and hold the
Alt key to temporarily use Lasso mode.

When enabled, selecting several control points will make a
manipulator bounding box appear. You can use this manipulator
to scale and rotate the selection of points.

Show Centerline Editor Controls

Apply to Line and Colour Art

Allows you to perform drawing operations on both the Line Art
and Colour Art layers of your drawing simultaneously.
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NOTE
If you have Overlay and Underlay Art layers enabled,
they will also be affected when this option is enabled.
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Close Gap Tool Properties
When you select the Close Gap tool, its properties and options appears in the Tool Properties view.

Tool Options
Icon

Property

Description

Auto-Flatten Mode

By default, when drawing on a vector layer, each new
stroke is created as a separate drawing object, which
can be edited independently from other parts of the
artwork. When enabled, the Auto-Flatten option
automatically merges strokes into existing artwork.
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Contour Editor Tool Properties
When you select the Contour Editor tool, its properties and options appear in the Tool Properties view.

Tool Options
Icon

Property

Description
Sets the selection mode to Lasso, which allows you to select multiple
items by drawing a lasso around them.

Lasso

TIP
When this option is enabled, you can press and hold the Alt
key to temporarily use Marquee mode.

Sets the selection mode to Marquee, which allows you to select
multiple items by drawing a rectangle around them.
Marquee

TIP
When this option is enabled, you can press and hold the Alt
key to temporarily use Lasso mode.

Snaps your selection or point to any line you position it on. As soon as
you move it close enough to another line, your point or selection will
snap to it.
Snap to Contour

Snap and Align

Snaps the selected anchor point to any existing line while displaying
temporary rulers as a guide that you can also snap your anchor point
to.
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When enabled, selecting several control points will make a manipulator
bounding box appear. You can use this manipulator to scale and rotate
the selection of points.

Show Contour Editor
Controls

Allows you to perform drawing operations on both the Line Art and
Colour Art layers of your drawing simultaneously.
Apply to Line and Colour
Art

NOTE
If you have Overlay and Underlay Art layers enabled, they will
also be affected when this option is enabled.

Operations
Icon

Property

Description
The Smooth operation lets you smooth out selected drawing strokes
and remove extra points.
l

From the top menu, select Selected > Smooth or press Alt +
Shift + S.

Smooth Selection

Split Pencil Line and Join
Pencil Lines

When drawing with the Polyline tool, your drawing has an even line
thickness. You can use the Pencil Editor to adjust the thickness point
by point, but if you want to adjust it quicker, you can use the Split
Pencil Line and Point Pencil Lines options to create segments and
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apply a pencil stencil to your drawing. Note that if you did not join the
pencil lines on your polyline stroke, the segments between the points
will act as separated segments.
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Cutter Tool Properties
When you select the Cutter tool, its properties and options appear in the Tool Properties view.

Tool Options
Icon

Property

Description
Sets the selection mode to Lasso, which allows you to select multiple items by
drawing a lasso around them.

Lasso

TIP
When this option is enabled, you can press and hold the Alt key to
temporarily use Marquee mode.

Sets the selection mode to Marquee, which allows you to select multiple items
by drawing a rectangle around them.
Marquee

TIP
When this option is enabled, you can press and hold the Alt key to
temporarily use Lasso mode.

Allows you to perform drawing operations on both the Line Art and Colour Art
layers of your drawing simultaneously.
Apply to Line and
Colour Art

NOTE
If you have Overlay and Underlay Art layers enabled, they will also be
affected when this option is enabled.

Use Mouse
Gesture

When using the Lasso selection type, the Use Mouse Gesture option lets you
automatically delete any extra sections of line in your artwork by simply dragging
your mouse over it.
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NOTE
For this operation to work, you lines CANNOT be flattened.

When using the Lasso selection type, the Use Mouse Gesture Breaker Mode
option lets you draw an invisible stroke on a pencil line to cut it in two individual
objects. Once a pencil line is cut with this option, you will be able to select the
two portions independently with either the Cutter tool, Pencil Editor tool or
Select tool.
Use Mouse
Gesture Breaker
Mode

NOTE
This option only works with pencil lines.

If you erase the end of a pencil line or erase a pencil line through the centre, new
line tips or line ends are created. Use the Tip Style option to customize the shape
of the new line tips that are created.
Tip Style

Antialiasing

When drawing on a bitmap layer, lines are no longer clean vector shapes. For the
edges to be smooth, a slight amount of antialiasing is used. When using the
Cutter tool, you can cut a portion of your drawing with or without antialiasing.
By default, the option is enabled. If you want to cut your drawing using a hard
edge, you can select the Antialiasing Off option.
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Operations
Icon

Property

Description

Flip Horizontal

Flips the current selection horizontally.

Flip Vertical

Flips the current selection vertically.

Rotate 90 Degrees
CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees
CCW

Rotates the current selection 90 degrees counter-clockwise.

62

Harmony 15.0 Paint Reference Guide

Drawing Pivot Tool Properties
The Drawing Pivot tool lets you set the pivots on your character. You can set the drawing pivots on drawings
and symbols.

Tool Options
Icon

Property

Description
The Set the Pivot for Symbol on All Frames option is
enabled by default. When you set a drawing pivot on
a symbol, all of its cells use the same drawing pivot.
This means you do not have to set a drawing pivot on
all frames. Once you set it, it is done.
If you prefer to set a different drawing pivot for a
series of cells, you can deselect the option and set
your pivots on each cell or cell range.

Setting the Drawing Pivot for Symbols on
All Frames

NOTE
If you have already set several different
pivots on your symbol's cells and selected
the Set the Pivot for Symbol on All Frames
option, once you set a new pivot on the
same symbol, all of its pivots will be reset
and will use your new pivot.

Snap to Contour

Snaps your selection or point to any line you position
it on. As soon as you move it close enough to another
line, your point or selection will snap to it.

Snap and Align

Snaps the selected anchor point to any existing line
while displaying temporary rulers as a guide that you
can also snap your anchor point to.

Snap to Grid

Snaps your selection following the currently enabled
grid.
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When you click the Reset Pivot option, the drawing
Reset Pivot

pivot of the selected drawing or symbol is reset to the
centre of the Camera view.
When you import new extra drawings, such as hands
and mouths, you can use the drawing pivot that was
set on your drawings and report them to the symbol's
cells. Use the Copy Pivot to Parent Symbol command
for this.

NOTE

Copying Pivot on Parent Symbol

When you copy drawing pivots to the parent
symbol, there is no link between the
drawings' pivots and the symbol's pivots. If
you modify the drawing pivot later, it will
not link to the symbol. You would need to
perform the operation again. If you need to
modify the symbol's pivots, you can do it
directly on the symbol's cells.
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Dropper Tool Properties
When you select the Dropper tool, its properties and options appears in the Tool Properties view.

Tool Options
Icon

Property

Description

Sample All Layers

On bitmap layers, if strokes with transparency located on separated art
layers overlap, the Dropper will pick the combination of the two colours.
When disabled, the Dropper will pick the colour on the current art layer.

Do not Pick
Transparency

On bitmap layers, when enabled, the dropper will pick the colour at 100%
of opacity even if the selection has some transparency.
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Ellipse Tool Properties
When you select the Ellipse tool, its properties and options appear in the Tool Properties view. There are a few
less options available when working on a bitmap layer.

Icon

Tool Name

Description
The Preview area lets you see a preview of the stroke your drawing tool
will make.

Previewing the Stroke

Size

Defines the width of the pencil line used to draw the circle.

Shape

You can adjust the start, end, and join style of a pencil line.
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l

l

l

Presets

Start: Lets you select the style of the start tip, which is the first tip
you drew. You can choose between Round or Flat style.
End: Lets you select the style of the end tip, which is the last tip
you drew. You can choose between Round or Flat style.
Join: Lets you select the joint style. The joints are where the line
curves abruptly. You could also define the Join style as the corner
style. You can choose between Round, Mitre and Bevel style.

Harmony provides a variety of presets and also lets you create and save
your own. It is a good idea to create and save pencils with precise sizes
and parameters when you draw and design for efficiency and
consistency.
All tools using pencil lines share the same preset list. Therefore, the
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same preset
list.

New Brush

Creates a new preset based on the current brush properties.

Delete Brush

Deletes the currently selected preset.

Rename Brush

Deletes the currently selected preset.

Import Brushes

Allows you to import brush presets exported from Harmony.

Export Brushes

Allows you to export your brush presets into an .xml file.

Small Thumbnail, Large
Thumbnail, and Stroke
View

Allows you to display the presets as small square thumbnails, large
square thumbnails or a list of stroke preview.

Draw Behind

When enabled, your brush strokes will appear behind the existing
artwork. Note that they will appear over your artwork while drawing your
stroke, until you release the brush.
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Use the Automatic Filling option to automatically fill your shape with the
selected colour as you draw. By default, the Shape tool creates the outline
of an empty shape that you can later fill using the Paint tool. This option
is unavailable for the line tool.
Automatic Filling

Snap to Contour

Snaps your selection or point to any line you position it on. As soon as
you move it close enough to another line, your point or selection will snap
to it.

Snap and Align

Snaps the selected anchor point to any existing line while displaying
temporary rulers as a guide that you can also snap your anchor point to.
Snaps your selection following the currently enabled grid.

Snap to Grid

As you draw in the Line Art layer, the Automatically Create Colour Art
option instantly creates the corresponding strokes in the Colour Art layer.
Automatically Create
Colour Art
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By default, when drawing on a vector layer, each new stroke is created as
a separate drawing object, which can be edited independently from other
parts of the artwork. When enabled, the Auto-Flatten option
automatically merges strokes into existing artwork.

Auto-Flatten Mode

NOTE
Using the Select tool, you can use select and remove a segment
of flattened pencil lines. Overlapping pencil lines drawn with the
Auto-Flatten mode are essentially cut into segments by the
overlap and can be treated as individual lines.

Use Stored Colour
Gradient

The Use Stored Colour Gradient option can be used when painting with a
gradient colour to always position the gradient in the same way it was
stored, making it consistent across brush strokes. You can store a
gradient by selecting a zone painted with a gradient with the Select tool,
then clicking on Store Colour Gradient

Draw Circle

in the Tool Properties view.

Enable this option to draw perfect circle (ratio 1:1) without holding any
keyboard shortcuts. As an alternative, you can hold down the Shift key.

Pencil Properties Dialog
The Ellipse tool draws the same type of line as the Pencil tool. Hence, you can configure the Ellipse tool's lines
using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke
display area in the Tool Properties view.

Size and Smoothness Tab
The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the
shape of its tips and corners.
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Tool Name

Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure
sensitive pen tablet, the width of the stroke will vary between its maximum size and
minimum size depending on the amount of pressure used. If used with a mouse, the
width of the stroke will always be its maximum size.

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you
do not have pressure sensitivity from a pen table, the minimum size value will be
ignored.

Smoothing

Defines the number of control points added to the centre line. The fewer the control
points the smoother (but less faithful) the line.

Contour Smoothing

Defines the number of points on the contour share of your stroke. This will smooth
out the bumps and waves on tour contour shape of your brush strokes.
You can adjust the start, end, and join style of a pencil line.

Shape
l

l

l

Start: Lets you select the style of the start tip, which is the first tip you drew.
You can choose between Round or Flat style.
End: Lets you select the style of the end tip, which is the last tip you drew.
You can choose between Round or Flat style.
Join: Lets you select the joint style. The joints are where the line curves
abruptly. You could also define the Join style as the corner style. You can
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choose between Round, Mitre and Bevel style.

Texture Tab
In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the current
pencil texture palette as the default one, or import the pencil texture palette into your scene.
The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the
Colour view—see Colour View on page 171.

Icon

Tool Name

Description

Use as Default Pencil
Texture Palette

Sets the currently selected pencil texture palette as the default pencil
texture palette in your user preferences. The default pencil texture palette
is added to every scene you create in Harmony. The palette is copied in
your preferences, so it will be added to your new scenes in the exact state
it is when you make it the default pencil texture palette.

Reload Default Texture
Palette

Imports the default pencil texture palette as a new pencil texture palette
into your scene's palette list, and selects it as the current pencil texture
palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in the
current pencil texture palette. The pencil texture's effect on your pencil line
will be based on the image's transparency channel, and will follow your
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pencil lines on its horizontal axis.

Delete Texture

Deletes a pencil texture swatch from the current pencil texture palette.

Rename Texture

Renames the selected pencil texture swatch in the current pencil texture
palette.

Pencil Texture List

Displays the pencil textures in the current pencil texture palette and allows
you to select one to use with the Pencil tool.

Pencil Texture Palette

Displays the name of the currently selectedpencil texture palette, for
reference. To select a different pencil texture palette, you must select it in
the Colour view—see Colour View on page 171.
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Envelope Tool Properties
Selecting the Envelope tool displays its properties and options in the Tool Properties view.

Icon

Tool Name

Description
Increase the width and height values to add more
columns and rows to the deformation grids.

Width and Height

Sets the selection mode to Lasso, which allows you to
select multiple items by drawing a lasso around them.

TIP

Lasso

When this option is enabled, you can press
and hold the Alt key to temporarily use
Marquee mode.

Sets the selection mode to Marquee, which allows you
to select multiple items by drawing a rectangle around
them.

Marquee
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TIP
When this option is enabled, you can press
and hold the Alt key to temporarily use
Lasso mode.

Snap to Contour

Snaps your selection or point to any line you position
it on. As soon as you move it close enough to another
line, your point or selection will snap to it.

Snap and Align

Snaps the selected anchor point to any existing line
while displaying temporary rulers as a guide that you
can also snap your anchor point to.
Snaps your selection following the currently enabled
grid.

Snap to Grid

To display more controls,you can click on the Show
Advanced Controls button.

Show Advanced Controls

Allows you to perform drawing operations on both
the Line Art and Colour Art layers of your drawing
simultaneously.

Apply to Line and Colour
Art
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NOTE
If you have Overlay and Underlay Art layers
enabled, they will also be affected when this
option is enabled.

Flip Horizontal

Flips the current selection horizontally.

Flip Vertical

Flips the current selection vertically.

Rotate 90 Degrees CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW

Rotates the current selection 90 degrees counterclockwise.
You can modify the central line smoothness of your
line using this option. This parameter smooths the
deformed lines. Increasing the value will result in a
smoother line with fewer control points. The more you
increase the value, the less details and curves you will
get. Use the left and right arrows to increment the

Smooth

value by one full unit. Use the Up - Down slider to
quickly increment the value.
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Eraser Tool Properties
When you select the Eraser

tool, its properties and options appear in the Tool Properties view.

The Eraser tool properties are almost identical to the Brush tool properties.

Icon

Tool Name

Description
The Preview area lets you see a preview of the stroke your drawing tool
will make.

Stroke Preview Area

Eraser Properties
Dialog

The arrow button right of the display area opens the Eraser Properties
dialog, which gives you access to all the parameters and options for your
eraser. The Tool Properties view only gives you access to a few of the
eraser properties, a list of eraser presets and options for the Eraser tool
that are not related to the eraser properties. For more information on
the Eraser Properties dialog, see the Eraser Tool Properties section below.

Maximum Size

Defines the maximum size of the eraser.
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If the tool is used with a pressure sensitive pen tablet, the width of the
stroke will vary between its maximum size and minimum size depending
on the amount of pressure used. If used with a mouse, the width of the
stroke will always be its maximum size.

Smoothing

Defines the number of control points added to the centre line. The fewer
the control points the smoother (but less faithful) the line.
Lets you set the opacity for each instance of the eraser tip that gets erased

Flow

from your artwork. Contrary to the Opacity parameter, the flow parameter
has a cumulative effect. This means that a lower flow will make your
eraser strokes less effective towards its extremities and more effective in
its center. Your stroke's flow will also accumulate if you draw over it. By
default, your eraser's flow varies with the amount of pressure you put on
your tablet pen.

NOTE
This option is only displayed in the Tool Properties view when
drawing on a bitmap layer.

The Opacity parameter are where Lets you set the opacity of your brush
strokes. Contrary to the Flow parameter, the Opacity parameter is non-

Opacity

cumulative. Your whole brush stroke's opacity will not exceed the Opacity
parameter. By default, the Opacity parameter varies depending on the
amount of pressure you put on your tablet pen.

NOTE
This option is only displayed in the Tool Properties view when
drawing on a bitmap layer.

New Eraser

Creates a new preset based on the current eraser properties.

Delete Eraser

Deletes the currently selected preset.

Rename Eraser

Deletes the currently selected preset.

Import Erasers

Allows you to import brush presets exported from Harmony.

Export Erasers

Allows you to export your brush presets into an .xml file.
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Small Thumbnail, Large
Thumbnail, and Stroke
View

Allows you to display the presets as small square thumbnails, large
square thumbnails or a list of stroke preview.

Allows you to perform drawing operations on both the Line Art and
Colour Art layers of your drawing simultaneously.
Apply to Line and
Colour Art

NOTE
If you have Overlay and Underlay Art layers enabled, they will
also be affected when this option is enabled.

If you erase the end of a pencil line or erase a pencil line through the
centre, new line tips or line ends are created. Use the Tip Style option to
customize the shape of the new line tips that are created.
Tip Style

Apply to Synced
Drawing Layers

When working on a synced layer, the tool is applied to the current layer
and all the layers that are synced to it. This option only works in the
Camera view.

Eraser Properties Dialog
Erasers have an extensive set of options and properties that are not displayed in the Tool Properties view, but
rather, in a dialog you can access from it. To open the Eraser Properties dialog, click on the arrow button right of
the stroke display area.

The Eraser Properties dialog has five different tabs, minus the Smoothing tab if you are working on a bitmap
layers. Below is detailed information about the options available in each tab:
l

Tip Tab on page 79

l

Smoothing Tab on page 83

l

Transparency Tab on page 84
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l

Dual Tip Tab on page 87

l

Paper Texture Tab on page 90

Tip Tab
The Tip tab allows you to configure the shape, size, hardness and spacing of your eraser tip.

Tool Name

Description
Allows you to select between one of the following eraser types:
l

Eraser Type

l

Solid Vector: Simply cuts out the eraser stroke's shape from
the vector artwork. A solid vector eraser always completely
erase the artworks leaving hard seams.
Textured Eraser: Allows to configure the eraser with the
same options as with a textured brush. A textured eraser will
decrease the opacity of bitmap textures in textured brush
strokes if it doesn't completely erase it. If it completely
erases a brush stroke, it will cut out the erased part from the
vector artwork.
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l

Textured, Preserve Vector: Like a Textured Eraser, except
that it will not cut out from the vector shapes, even if it fully
erases pixels in a textured brush stroke's texture.

NOTE
Textured erasers only work as expected on textured brush
strokes. Using a Textured eraser on a solid vector brush
stroke or on a pencil line will only cut the eraser stroke's
shape out of it. If you use a Textured, Preserve Vector type
eraser on a solid vector shape or on a pencil line, the eraser
will not erase anything.

NOTE
This option is not available when working on a bitmap
layer. With bitmap layers, erasers are always textured, and
textured eraser options are always available.

This is where you select the shape of the eraser tip. By default, it is
round. Note that some tips are designed to have semitransparent
areas, even when the maximum eraser opacity is set to 100%.
Eraser Tip Library

To create a custom eraser tip, you must prepare the file ahead of
time, either in Harmony or in a third-party software, such as Adobe
Photoshop. Colour is not supported and transparency is not
supported in the traditional sense. Black appears as 100% opaque,
white appears as 100% transparent and all the shades of grey in
between appear as varying degrees of semitransparency. A range of
file formats are supported—.jpeg, .png, .tif, .psd, .tga to name a few.
Alpha channels are disregarded on import. It is recommended that
your file be between 100 x 100 pixels and 400 x 400 pixels.
You can also import eraser tips that you exported from Harmony, so
you can share them with colleagues.

Minimum and Maximum Size

The minimum and maximum sizes of your drawing tool produce the
thick and thin effect on your stroke. This works with the pressure
sensitivity of a pen tablet.
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l

l

Maximum Size: Defines the maximum width of the stroke.
Minimum Size: Defines the minimum width of the stroke in
relation to and as a percentage of the maximum size.

NOTE
Setting the Minimum Size value to 100% eliminates the
possibility of creating width variation on your stroke. In
other words, you would be forcing a uniform line width
using the Maximum Size value.

The Roundness and Angle parameters allow you to change the
shape and orientation of the tip.
l

Roundness and Angle
l

Roundness: Squashes the height of the tip from its centre
point. 100% roundness = the native height of the tip. A
smaller percentage will make the brush tip look flatter and
more narrow. The squashing is NOT relative to the angle
value—if the tip is rotated, the squashing function still uses
the brush tip's original orientation.
Angle: Rotates the brush tip counter-clockwise. 0° = the
tip's native orientation.

The Hardness and Spacing parameters allow you to change the
softness and spacing of the marks made by the eraser tip. You can
preview the hardness and spacing at the top of the Eraser
Properties window, stroke preview area.

Hardness

Spacing

The hardness value corresponds to the softness of the eraser tip's
edges. The lower the value, the softer the tip edge. The higher the
value, the sharper the tip edge. Be aware that some eraser tips are
not 100% opaque, so they will always appear somewhat soft, even
at 100% hardness.

Defines the amount of space between each stamp of the eraser. A
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value of 100% sets the stamp marks edge to edge, if there is no
white space around the shape. The larger the value, the greater the
space between marks. A really large value can make the eraser
stroke appear as a string of individual marks. Conversely, a small
spacing value will give the appearance of a fluid brush stroke.
Spacing is only evident when making a continuous stroke.

Randomness

The Randomness parameters let you create a varied bitmap eraser
stroke. Refining these options can give your stroke a lovely, nonmechanical look.
You can create variation between the thick and thin of your eraser
stroke just by setting the Maximum and Minimum Size values. If you
add randomness to the mix, pressure sensitivity from your drawing
tablet will still be applied. Light pressure will create random values
around the minimum, while heavy pressure will create random
values closer to the maximum. The larger the percentage, the larger
the range of random variation.

Random Size

NOTE
Setting the Minimum Size to 100% eliminates the
possibility of creating width variation on your stroke,
whether you are applying randomness or not. Therefore,
you would be forcing a uniform line width using the
Maximum Size value.

Random Angle

Sets the range for random rotation around the set Angle value. For
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example, if the Angle is set to 45° and the Random Angle set to 10°,
the software will choose values between 40°–50° (plus or minus 5
degrees, equaling a total of 10 degrees).

Sets the range for random spacing around the set Spacing value.
For example, if the Spacing is set to 50% and the Random Spacing
is set to 10%, then Harmony will choose values between 45%–55%
(plus or minus 5 percent, equaling a total of 10 percent).

Random Spacing

Smoothing Tab
The Smoothing tab contains options to configure how Harmony should automatically smooth your eraser
strokes as you paint.

83

Chapter 2: Tools Properties

NOTE
The Smoothing tab is only available when working on a vector layer, as bitmap layers do not
support smoothing.

Tool Name

Description

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on your eraser stroke's
direction, curves and corners. A higher setting will prevent your line from being
shaky, but is liable to reduce drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on outer contour of the
eraser stroke. A higher setting will round sharp corners and reduce the amount of
control points for the resulting vector shape.

Transparency Tab
The Transparency tab allows you to decide if your eraser has antialiasing as well as to set its flow and opacity
settings.
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NOTE
The Transparency tab's options are only available on vector layers if the Eraser Type option of the
Tip tab is set to Textured Vector or Textured, Preserve Vector.. On bitmap layers, those options
are always available.

Tool Name

Description
Enabled by default. This option causes the contours of the eraser strokes to
blend with the surrounding colours, to create an illusion of smoothness
otherwise not possible due to the picture resolution.

Antialiasing

If antialiasing is disabled, the eraser will either fully erase pixels or leave them
intact.

NOTE
When disabled, all other options in the Transparency tab are disabled.

The Maximum and Minimum Flow parameters let you set the range for the rate at
which your eraser's effect flows. The greater the flow, the more consistent the
effect is. If the flow is light, then the effect may look spotty. This feature works
with the pressure sensitivity of a pen tablet.
l

l

Maximum and Minimum Flow

Maximum Opacity and
Minimum Opacity

Maximum Flow: Sets the maximum rate at which colour and texture are
applied as you create a fluid stroke.
Minimum Flow: Sets the minimum rate at which colour and texture are
applied as you create a fluid stroke. It is defined as a percentage of the
Maximum Flow value. If the Minimum Flow value is set to 100%, then
tablet pressure sensitivity will no longer be applicable. The flow will be
set to the constant rate of the Maximum Flow value.

The Maximum and Minimum Opacity parameters are where you set the opacity
range for a eraser mark. This works with the pressure sensitivity of a pen tablet.
l

Maximum Opacity: Sets the transparency limit of the eraser mark when
the pressure is heavy.
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l

Randomness

Minimum Opacity: Sets the transparency limit of the eraser mark when
the pressure is very light. It is defined as a percentage of the Maximum
Opacity value. If the Minimum Opacity value is set to 100%, then tablet
pressure sensitivity will no longer be applicable. The opacity will be set to
the constant rate of the Maximum Opacity value.

Th Randomness parameter lets you set the range for the randomness of the flow
and opacity. This works with the pressure sensitivity of a pen tablet.
You can create variation in the flow of your eraser stroke just by setting the
Maximum and Minimum Flow values. If you add randomness to the mix, pressure
sensitivity from your drawing tablet will still be applied. Light pressure will create
random values around the minimum, while heavy pressure will create random
values closer to the maximum. The larger the percentage, the larger the range of
random variation.

Randomness Flow

NOTE
Setting the Minimum Flow value to 100% eliminates the possibility of
creating flow variation on your stroke, whether you are applying
randomness or not. That is, you would be forcing a uniform flow using the
Maximum Flow value.
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Maximum and Minimum Opacity values. If you add randomness to the mix,
pressure sensitivity from your drawing tablet will still be applied. Light pressure
will create random values around the minimum, while heavy pressure will create
random values closer to the maximum. The larger the percentage, the larger the
range of random variation.

NOTE
Setting the Minimum Opacity value to 100% eliminates the possibility of
creating opacity variation on your stroke, whether you are applying
randomness or not. That is, you would be forcing a uniform opacity using
the Maximum Opacity value.

Dual Tip Tab
The Dual Tip tab lets you set the parameters for creating a dual tip eraser. The primary bitmap eraser tip and
the dual tip always work together. You can set the parameters for the primary tip in the Tip tab and those for
the dual tip in the Dual Tip tab. The Blend mode you select determines how the tips are combined.
By default, the Blend Mode is set to Multiply and the Random Angle to 360°.
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NOTE
To use a Dual Tip, you must enable option by checking the checkbox inside the Dual Tip tab.
Additionally, if you are working on a vector layer, the Eraser Type option of the Tip tab must be set
to Textured Vector or Textured, Preserve Vector.

Tool Name

Description

Enable/Disable

The checkbox inside the tab allows you to decide whether or not your eraser uses a
dual tip. If this checkbox is unchecked, the options in the Dual Tip tab will be
disabled.

Blend Mode

The Blend modes let you decide how the primary tip and the dual tip are combined.

Multiply

This is the default blend mode. When the two eraser tips are combined in this mode,
they essentially cut each other out in overlapping areas, where one or both tips have
an area of 100% transparency. The less opaque the eraser tips are, the lighter their
combination.
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In this mode, the primary tip cuts out the shape of the dual tip. Where the tip shapes
overlap, within the boundaries of the primary shape, the colour and opacity appear
darker.

Colour Dodge
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This mode treats the two tips as two different and separate erasers that have the
same colour and follow the same path.

Combine

Paper Texture Tab
The Paper Texture tab lets you configure a paper-like texture for your eraser. You can also add textures by
importing image files, or import paper textures that were previously exported from Harmony.
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NOTE
To use a Paper Texture, you must enable option by checking the checkbox inside the Paper
Texture tab. Additionally, if you are working on a vector layer, the Eraser Type option of the Tip tab
must be set to Textured Vector or Textured, Preserve Vector.

Tool Name

Description
The checkbox inside the tab allows you to decide whether or not your eraser uses a

Enable/Disable

paper texture. If this checkbox is unchecked, the options in the Paper Texture tab will
be disabled.

Texture Scale

Increase or decreases the size of the paper texture.
This option layers the texture on top of itself as you scribble overlapping lines in one
continuous stroke. If this option is turned off, areas of overlapping lines from a single,
continuous stroke will appear the same, in terms of darkness and texture, as nonoverlapping areas.

Additive

This option defines the way separate, overlapping strokes behave. If this option is
enabled, the paper texture's position does not change with each sweep of the eraser.
If this option is disabled, each sweep of the eraser produces a different texture
position. The texture orientation always stays the same.

Aligned
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Ink Tool Properties
When you select the Ink tool, its properties and options appear in the Tool Properties view.

Icon

Tool Name

Tool
Sets the selection mode to Lasso, which allows
you to select multiple items by drawing a lasso
around them.

Lasso

TIP
When this option is enabled, you can
press and hold the Alt key to temporarily
use Marquee mode.

Sets the selection mode to Marquee, which allows
you to select multiple items by drawing a rectangle
around them.
Marquee

TIP
When this option is enabled, you can
press and hold the Alt key to temporarily
use Lasso mode.

Show Inkable Lines

Highlights all pencil lines (no brush strokes) on the
selected layer. Pencil line segments that are already
inked with the selected swatch colour from the
colour palette are also not highlighted.

Be Smart on Connecting Lines

As you hover and move the cursor across
intersecting pencil lines, the path that you create
will be highlighted. When you click on your mouse
or stylus the highlighted segments are inked. With
this option disabled, all the intersecting segments
that your cursor comes near will be highlighted
and become part of the selection, even if they were
not situated in the direction of the chosen path.
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NOTE
This option only works if the Ink tool is in
Hover mode.

Use this mode instead of the Hover Mode. In the
Hover Mode, any potentially inkable pencil line will
have its central vector line highlighted as the Ink
tool’s cursor hovers over it. Use Ctrl

Select Mode

(Windows/Linux) or ⌘ (macOS) to toggle between
the two modes.
In the Paint tool properties, this option keeps a
selection highlighted around the latest painted
zone after using the Paint, Repaint, Unpaint, or
Paint Unpainted tool.

Select Newly Painted, Repainted,
and Unpainted Contours/Lines

Raise

As you ink the pencil line, the segment will be
moved on top of the other intersecting strokes.
Disable this option for the line to be sent behind.
Hold down the Alt key to perform the opposite
operation as you ink.

Mitre

As you hover over two perpendicular or nearly
perpendicular segments, a highlighted path with a
corner is created. Clicking on these highlighted
segments inks both segments and makes them
appear as a single stroke with a corner or bend.
Options include: As Is, Round, Miter, and Bevel.

Tip Style

Lets you customize the edge of the Ink tool.
Options include: Round, Flat, and Bevel.
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Line Tool Properties
When you select the Line tool, its properties and options appear in the Tool Properties view. There are a few
less options available when working on a bitmap layer.

Icon

Tool Name

Description
The Preview area lets you see a preview of the stroke your drawing tool
will make.

Previewing the Stroke

Size

Defines the width of the pencil line used to draw the line.

Shape

You can adjust the start, end, and join style of a pencil line.
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l

l

l

Presets

Start: Lets you select the style of the start tip, which is the first tip
you drew. You can choose between Round or Flat style.
End: Lets you select the style of the end tip, which is the last tip
you drew. You can choose between Round or Flat style.
Join: Lets you select the joint style. The joints are where the line
curves abruptly. You could also define the Join style as the corner
style. You can choose between Round, Mitre and Bevel style.

Harmony provides a variety of presets and also lets you create and save
your own. It is a good idea to create and save pencils with precise sizes
and parameters when you draw and design for efficiency and
consistency.
All tools using pencil lines share the same preset list. Therefore, the
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same preset
list.

New Brush

Creates a new preset based on the current brush properties.

Delete Brush

Deletes the currently selected preset.

Rename Brush

Deletes the currently selected preset.

Import Brushes

Allows you to import brush presets exported from Harmony.

Export Brushes

Allows you to export your brush presets into an .xml file.

Small Thumbnail, Large
Thumbnail, and Stroke
View

Allows you to display the presets as small square thumbnails, large
square thumbnails or a list of stroke preview.

Draw Behind

When enabled, your brush strokes will appear behind the existing
artwork. Note that they will appear over your artwork while drawing your
stroke, until you release the brush.
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Snap to Contour

Snaps your selection or point to any line you position it on. As soon as
you move it close enough to another line, your point or selection will snap
to it.

Snap and Align

Snaps the selected anchor point to any existing line while displaying
temporary rulers as a guide that you can also snap your anchor point to.
Snaps your selection following the currently enabled grid.

Snap to Grid

As you draw in the Line Art layer, the Automatically Create Colour Art
option instantly creates the corresponding strokes in the Colour Art layer.
Automatically Create
Colour Art

By default, when drawing on a vector layer, each new stroke is created as
a separate drawing object, which can be edited independently from other
parts of the artwork. When enabled, the Auto-Flatten option
automatically merges strokes into existing artwork.
Auto-Flatten Mode
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NOTE
Using the Select tool, you can use select and remove a segment
of flattened pencil lines. Overlapping pencil lines drawn with the
Auto-Flatten mode are essentially cut into segments by the
overlap and can be treated as individual lines.

When using the pencil tool, you can automatically close strokes with an
invisible stroke.

Auto-Close Gap

It is recommended to keep this option enabled when drawing with the
Pencil tool.
The Line Building mode is very useful when drawing long lines and
curves in small increments with pencil lines or the Line tool. As the pencil
lines are central vector lines, it may be difficult to align the line tips
perfectly to create a uniform stroke and close all gaps.
In this mode, you can draw lines in small increments and the tips are
merge into one single stroke.

Line Building Mode

NOTE
This mode only works with pencil lines or the line tool.

Use Stored Colour
Gradient

The Use Stored Colour Gradient option can be used when painting with a
gradient colour to always position the gradient in the same way it was
stored, making it consistent across brush strokes. You can store a
gradient by selecting a zone painted with a gradient with the Select tool,
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then clicking on Store Colour Gradient

in the Tool Properties view.

Enable this option to draw perfect circle (ratio 1:1) without holding any
keyboard shortcuts. As an alternative, you can hold down the Shift key.

Draw Circle

Pencil Properties Dialog
Since the Line tool draws pencil lines, you can use the Pencil Properties dialog to customize the type of lines it
draws. To open the Pencil Properties dialog, click on the arrow button right of the stroke display area.

Size and Smoothness Tab
The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the
shape of its tips and corners.

Tool Name

Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure
sensitive pen tablet, the width of the stroke will vary between its maximum size and
minimum size depending on the amount of pressure used. If used with a mouse, the
width of the stroke will always be its maximum size.

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you
do not have pressure sensitivity from a pen table, the minimum size value will be
ignored.
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Smoothing

Defines the number of control points added to the centre line. The fewer the control
points the smoother (but less faithful) the line.

Contour Smoothing

Defines the number of points on the contour share of your stroke. This will smooth
out the bumps and waves on tour contour shape of your brush strokes.
You can adjust the start, end, and join style of a pencil line.

Shape

l

l

l

Start: Lets you select the style of the start tip, which is the first tip you drew.
You can choose between Round or Flat style.
End: Lets you select the style of the end tip, which is the last tip you drew.
You can choose between Round or Flat style.
Join: Lets you select the joint style. The joints are where the line curves
abruptly. You could also define the Join style as the corner style. You can
choose between Round, Mitre and Bevel style.

Texture Tab
In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the current
pencil texture palette as the default one, or import the pencil texture palette into your scene.
The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the
Colour view—see Colour View on page 171.
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Icon

Tool Name

Use as Default Pencil
Texture Palette

Description
Sets the currently selected pencil texture palette as the default pencil
texture palette in your user preferences. The default pencil texture palette
is added to every scene you create in Harmony. The palette is copied in
your preferences, so it will be added to your new scenes in the exact state
it is when you make it the default pencil texture palette.

Reload Default Texture
Palette

Imports the default pencil texture palette as a new pencil texture palette
into your scene's palette list, and selects it as the current pencil texture
palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in the
current pencil texture palette. The pencil texture's effect on your pencil line
will be based on the image's transparency channel, and will follow your
pencil lines on its horizontal axis.

Delete Texture

Deletes a pencil texture swatch from the current pencil texture palette.

Rename Texture

Renames the selected pencil texture swatch in the current pencil texture
palette.

Pencil Texture List

Displays the pencil textures in the current pencil texture palette and allows
you to select one to use with the Pencil tool.

Pencil Texture Palette

Displays the name of the currently selectedpencil texture palette, for
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reference. To select a different pencil texture palette, you must select it in
the Colour view—see Colour View on page 171.
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Paint Tool Properties
When you select the Paint tool, its properties and options appears in the Tools Properties view.

Icon

Tool Name

Description
Sets the selection mode to Lasso, which allows you to
select multiple items by drawing a lasso around them.

TIP

Lasso

When this option is enabled, you can press
and hold the Alt key to temporarily use
Marquee mode.

Sets the selection mode to Marquee, which allows you
to select multiple items by drawing a rectangle around
them.
Marquee

TIP
When this option is enabled, you can press
and hold the Alt key to temporarily use
Lasso mode.

The Paint tool has four different modes available:
l

l

Paint Modes
l

l
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The Paint mode paints everything it touches,
including empty and filled zones.
The Paint Unpainted mode paints only empty
zones. Any line or filled zone will remain
unchanged.
The Repaint mode paints everything it touches
except empty zones. Any zone that is not
painted will remain intact.
The Unpaint mode unpaints everything it
touches, including empty and filled zones.
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The Paint and Remove Texture option is used when
you vectorized images as greyscale texture style. An
image vectorized as texture is a mix of bitmap filling
encapsulated in a vector-based frame. Painting a
textured zones with the Paint tool will change the tint
of the textured lines. Painting the textured zones using
the Paint and Remove Texture option transforms the
bitmap filling into a 100% vector based zone and fills
it with a solid colour.
Paint and Remove
Textures

The Apply to Multiple Drawings option is used for fast
painting in hand-drawn animation. When you want to
paint several drawings in a same layer at once, such as
a walk cycle, you can enable this option and make a
selection in the Drawing view. All the closed zones
located within your Paint tool selection are painted
with the selected colour swatch.

Apply to Multiple
Drawings

You do not need to enable the Onion Skin preview to
use this option. The option will stay enabled only for
the next action. If you want to use it again, you must
click on the Apply to Multiple Drawings button again,
or press Alt + A.
The Respect Protected Colour option is enabled by

Respect Protected Colour
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default. In your Colour view, you can protect some
colour swatches to avoid repainting or unpainting the
zones linked to that swatch.
If you disable this option the Paint tool will not follow
the protect colour rule and will repaint or unpaint the
protected colours on your drawings until you enable
the option again.
When you paint a zone with a gradient or textured
colour swatch, the gradient or texture’s position is set
relative to the size of the zone you are painting. If you
want the Paint tool to use a particular size and
position, you must first store your desired position
and size using the Select tool and then enable the Use
Stored Colour Gradient option in the Paint tool
properties.
Use Stored Colour
Gradient

In the Paint tool properties, this option keeps a
selection highlighted around the latest painted zone
after using the Paint, Repaint, Unpaint, or Paint
Unpainted tool.

Select Newly Painted,
Repainted, and Unpainted
Contours/Lines

The Close Gap option has four modes available. When
the option is enabled, Harmony will consume more
resources while painting.

Close Gap
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l

l

l

l
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No Close Gap: The moment a zone has a gap in
it, the Paint tool will not fill the area.
Close Small Gap: If a zone has a small gap in it,
the Paint tool will fill the area. You can zoom
out to make the gap appear smaller and the
Paint tool will paint.
Close Medium Gap: If a zone has a medium gap
in it, the Paint tool will fill the area. You can
zoom out to make the gap appear smaller and
the Paint tool will paint.
Close Large Gap: If a zone has a large gap in it,
the Paint tool will fill the area. You can zoom
out to make the gap appear smaller and the
Paint tool will paint.
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Pencil Tool Properties
When you select the Pencil

tool, its properties and options appears in the Tool Properties view.

Pencil Properties
The following properties affect the pencil's size, smoothing, shape and other properties for the drawing style of
your pencil. Those properties can be saved into pencil presets for later use.
Icon

Tool Name

Description
The Preview area lets you see a preview of the stroke your drawing tool
will make.

Preview Area

The arrow button right of the preview area opens the Pencil Properties
dialog.
Pencil Properties
Dialog

While the Tool Properties view only gives you access to a few of the
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pencil properties, a list of pencil presets and other drawing options, the
Pencil Properties dialog gives you access to all the available options for
your pencil's shape and texture. For more information on
the Pencil Properties dialog, see the Pencil Properties Dialog section
below.
Defines the maximum width of the pencil line.
Maximum Size

If the tool is used with a pressure sensitive pen tablet, the width of the
stroke will vary between its maximum size and minimum size depending
on the amount of pressure used. If used with a mouse, the width of the
stroke will always be its maximum size.

Smoothing

Defines the number of control points added to the centre line. The fewer
the control points the smoother (but less faithful) the line.
You can adjust the start, end, and join style of a pencil line.

Shape

l

l

l

Start: Lets you select the style of the start tip, which is the first tip
you drew. You can choose between Round or Flat style.
End: Lets you select the style of the end tip, which is the last tip
you drew. You can choose between Round or Flat style.
Join: Lets you select the joint style. The joints are where the line
curves abruptly. You could also define the Join style as the corner
style. You can choose between Round, Mitre and Bevel style.

Pencil Presets
These options allow you to select, create and manage pencil presets.
Icon

Tool Name

Description

Presets list

Harmony provides a variety of pencil presets and thickness stencils and
also lets you create and save your own. It is a good idea to create and
save pencils with precise sizes and parameters when you draw and
design for efficiency and consistency.
A thickness stencil saves the thickness information across the length of
the line. When drawing with a thickness stencil, the pressure sensitivity
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of the tablet is discarded. A thickness stencil can be used while drawing,
or applied afterwards.
You also have the possibility to apply different textures to your lines by
either using the default presets or importing your own.
You can export the pencil presets that you have created and import those
that others have created. This is a good way for you and project
collaborators to keep a consistent look for the project.

New Preset

Creates a new preset based on the current brush properties.

Delete Preset

Deletes the currently selected preset.

Presets Menu

Gives access to more options for managing presets.

Rename Brush

Deletes the currently selected preset.

Import Brushes

Allows you to import brush presets exported from Harmony.

Export Brushes

Allows you to export your brush presets into an .xml file.

Small Thumbnail

Displays presets in a grid of small thumbnails with a preview of their tip.

Large Thumbnail

Displays presets in a grid of big thumbnails, with their name and a
preview of their tip.

Stroke View

Displays presets in a list, with their name and a preview of a stroke done
with each preset. This is the default setting.

Drawing Options
These options affect the way your drawing strokes are integrated into your artwork.
When enabled, your brush strokes will appear behind the existing
artwork. Note that they will appear over your artwork while drawing your
stroke, until you release the brush.
Draw Behind
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When enabled, drawing a closed shape will automatically fill it with the
currently selected Paint colour.

Auto Fill

TIP
By default the pencil line and its fill will be the same colour. If
you want to select different colours for the pencil line and its fill,
you can click on the Unlock Three Colours

button in the

Colour view, then select different colours for Brush strokes
, Pencil lines

and Paint fills

.

When enabled, drawing a closed shape will automatically remove the
outstanding lines.
Trim Extra Lines

When the Trim Extra Lines option is enabled, enable this option to make
the point where the beginning and end of the stroke meet into a smooth
curve rather than a hard corner.

Align Handles After
Trim

Automatically Create
Colour Art

As you draw in the Line Art layer, the Automatically Create Colour Art
option instantly creates the corresponding strokes in the Colour Art layer.
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By default, when drawing on a vector layer, each new stroke is created as
a separate drawing object, which can be edited independently from other
parts of the artwork. When enabled, the Auto-Flatten option
automatically merges strokes into existing artwork.

Auto-Flatten Mode

NOTE
Using the Select tool, you can use select and remove a segment
of flattened pencil lines. Overlapping pencil lines drawn with the
Auto-Flatten mode are essentially cut into segments by the
overlap and can be treated as individual lines.

When using the pencil tool, you can automatically close strokes with an
invisible stroke.

Auto-Close Gap

It is recommended to keep this option enabled when drawing with the
Pencil tool.

Line Building Mode

The Line Building mode is very useful when drawing long lines and
curves in small increments with pencil lines or the Line tool. As the pencil
lines are central vector lines, it may be difficult to align the line tips
perfectly to create a uniform stroke and close all gaps.
In this mode, you can draw lines in small increments and the tips are
merge into one single stroke.
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NOTE
This mode only works with pencil lines or the line tool.

The Auto Adjust Thickness tool is useful when you want to render a
portion of a line thicker. When tracing a drawing on paper, you will often
go back to a section of a curve to make it thicker to add dynamism to the
line. Using the Auto Adjust Thickness tool, you can draw highlight
strokes over the section to make thicker. Once you release the pen or
mouse, the line becomes thicker following the shape and curve of the
original stroke. This way is much faster and smoother than using the
Pencil Editor tool. You do not have to add extra points and adjust the
position and Bezier handles.
Auto Adjust Thickness

The default overlay colour is light yellow. If this colour is difficult to see
because of the background or drawing colour, you can adjust the colour.

Line Pushing Mode

The Line Pushing Mode option lets you draw highlight strokes over
existing pencil lines. You can reshape the curves. Depending how you
draw the pushing stroke over your line, the highlighted section will be
reshaped in one direction or the other.
The default overlay colour is light yellow. If this colour is difficult to see
because of the background or drawing colour, you can adjust the colour.

Colour

You can change the colour of the temporary strokes that appear in the
drawing space when using the Line Pushing Mode or the Auto Adjust
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Thickness option by clicking on the Colour swatch and selecting a new
colour in the Colour Picker dialog.

Pencil Properties Dialog
Pencils have extra parameters which are not accessible from the Tool Properties view. To open the Pencil
Properties dialog, click on the arrow button right of the stroke display area.

Size and Smoothness Tab
The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the
shape of its tips and corners.

Tool Name

Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure
sensitive pen tablet, the width of the stroke will vary between its maximum size and
minimum size depending on the amount of pressure used. If used with a mouse, the
width of the stroke will always be its maximum size.

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you
do not have pressure sensitivity from a pen table, the minimum size value will be
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ignored.

Smoothing

Defines the number of control points added to the centre line. The fewer the control
points the smoother (but less faithful) the line.

Contour Smoothing

Defines the number of points on the contour share of your stroke. This will smooth
out the bumps and waves on tour contour shape of your brush strokes.
You can adjust the start, end, and join style of a pencil line.

Shape

l

l

l

Start: Lets you select the style of the start tip, which is the first tip you drew.
You can choose between Round or Flat style.
End: Lets you select the style of the end tip, which is the last tip you drew.
You can choose between Round or Flat style.
Join: Lets you select the joint style. The joints are where the line curves
abruptly. You could also define the Join style as the corner style. You can
choose between Round, Mitre and Bevel style.

Texture Tab
In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the current
pencil texture palette as the default one, or import the pencil texture palette into your scene.
The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the
Colour view—see Colour View on page 171.
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Icon

Tool Name

Use as Default Pencil
Texture Palette

Description
Sets the currently selected pencil texture palette as the default pencil
texture palette in your user preferences. The default pencil texture palette
is added to every scene you create in Harmony. The palette is copied in
your preferences, so it will be added to your new scenes in the exact state
it is when you make it the default pencil texture palette.

Reload Default Texture
Palette

Imports the default pencil texture palette as a new pencil texture palette
into your scene's palette list, and selects it as the current pencil texture
palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in the
current pencil texture palette. The pencil texture's effect on your pencil line
will be based on the image's transparency channel, and will follow your
pencil lines on its horizontal axis.

Delete Texture

Deletes a pencil texture swatch from the current pencil texture palette.

Rename Texture

Renames the selected pencil texture swatch in the current pencil texture
palette.

Pencil Texture List

Displays the pencil textures in the current pencil texture palette and allows
you to select one to use with the Pencil tool.

Pencil Texture Palette

Displays the name of the currently selectedpencil texture palette, for
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reference. To select a different pencil texture palette, you must select it in
the Colour view—see Colour View on page 171.
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Pencil Editor Tool Properties
When you select the Pencil Editor tool, its properties and options appear in the Tool Properties view.
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Icon

Tool Name

Description
Sets the selection mode to Lasso, which allows you to select multiple
items by drawing a lasso around them.

Lasso

TIP
When this option is enabled, you can press and hold the Alt key
to temporarily use Marquee mode.

Sets the selection mode to Marquee, which allows you to select multiple
items by drawing a rectangle around them.
Marquee

TIP
When this option is enabled, you can press and hold the Alt key
to temporarily use Lasso mode.

Defines the maximum width of the pencil line.
Maximum Size

If the pencil line has a constant size, this will define the width of the
pencil line all over. If the pencil line has a varying size, this will define the
width of its larger areas. Areas that are in-between the maximum and
minimum size will be resized proportionally.

Minimum Size

Defines the minimum width of the pencil line. If the pencil line has a
varying size, this will define the width of its smaller areas. Areas that are
in-betwen the maximum and minimum size will be resized proportionally.
You can adjust the start, end, and join style of a pencil line.

Shape

l

l

l

Start: Lets you select the style of the start tip, which is the first tip
you drew. You can choose between Round or Flat style.
End: Lets you select the style of the end tip, which is the last tip
you drew. You can choose between Round or Flat style.
Join: Lets you select the joint style. The joints are where the line
curves abruptly. You could also define the Join style as the corner
style. You can choose between Round, Mitre and Bevel style.
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Harmony provides a variety of pencil presets and thickness stencils and
also lets you create and save your own. It is a good idea to create and
save pencils with precise sizes and parameters when you draw and
design for efficiency and consistency.

Presets

A thickness stencil saves the thickness information across the length of
the line. When drawing with a thickness stencil, the pressure sensitivity
of the tablet is discarded. A thickness stencil can be used while drawing,
or applied afterwards.
You also have the possibility to apply different textures to your lines by
either using the default presets or importing your own.
You can export the pencil presets that you have created and import those
that others have created. This is a good way for you and project
collaborators to keep a consistent look for the project.

New Brush

Allows to create a new preset from the selected pencil line.

Delete Brush

Deletes the currently selected preset.

Rename Brush

Deletes the currently selected preset.

Small Thumbnail, Large
Thumbnail, and Stroke
View

Allows you to display the presets as small square thumbnails, large
square thumbnails or a list of stroke preview.

Use as Default Pencil
Texture Palette

Sets the currently selected pencil texture palette as the default pencil
texture palette in your user preferences. The default pencil texture palette
is added to every scene you create in Harmony. The palette is copied in
your preferences, so it will be added to your new scenes in the exact state
it is when you make it the default pencil texture palette.

Reload Default Texture
Palette

Imports the default pencil texture palette as a new pencil texture palette
into your scene's palette list, and selects it as the current pencil texture
palette.

New Texture

Adds a new custom pencil texture to the list.

Delete Texture

Deletes a texture preset from the list.

Rename Texture

Renames the selected texture to keep the list organized.

Presets

Harmony provides a variety of pencil texture presets and also lets you
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create and save your own.

Pencil Texture Palette

Displays the colour palette assigned to hold the pencil textures. Use the
Colour View menu to assign a new palette.
The Smooth operation lets you smooth out selected drawing strokes and
remove extra points.
l

From the top menu, select Selected > Smooth or press Alt + Shift
+ S.

Smooth Selection

The Pump Pencil Pressure option is used to increase the line thickness of
a selected area on a pencil line.

Pump Pencil Pressure

The Deflate Pencil Pressure option is used to decrease the line thickness
of a selected area on a pencil line.

Deflate Pencil Pressure

Merge Pencil Lines

Pencil lines are central vector lines and it might be difficult to match
pencil line’s tips properly to align them and make it look like it is one

120

Harmony 15.0 Paint Reference Guide

single line. With the Select tool, you can select several pencil lines and
merge them as one single object using the Merge Pencil Lines option. The
ends of your lines are adjusted to form one single line.

The Reverse Pencil Thickness option inverts the thick and thin section on
a selected pencil line. This option will take the thickest size on the line
and apply it to the thinnest, and it will apply the thinnest to the thickest.

Reverse Pencil Thickness
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Perspective Tool Properties
Selecting the Perspective tool displays its properties and options in the Tool Properties view.

Icon

Tool Name

Description

Selection Tool Options
Sets the selection mode to Lasso, which allows you to
select multiple items by drawing a lasso around them.

TIP

Lasso

When this option is enabled, you can press
and hold the Alt key to temporarily use
Marquee mode.

Sets the selection mode to Marquee, which allows you
to select multiple items by drawing a rectangle around
them.
Marquee

TIP
When this option is enabled, you can press
and hold the Alt key to temporarily use
Lasso mode.

Snap to Contour

Snaps your selection or point to any line you position
it on. As soon as you move it close enough to another
line, your point or selection will snap to it.

Snap and Align

Snaps the selected anchor point to any existing line
while displaying temporary rulers as a guide that you
can also snap your anchor point to.

Snap to Grid

Snaps your selection following the currently enabled
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grid.

Allows you to perform drawing operations on both the
Line Art and Colour Art layers of your drawing
simultaneously.
Apply to Line and Colour
Art

NOTE
If you have Overlay and Underlay Art layers
enabled, they will also be affected when this
option is enabled.

Flip Horizontal

Flips the current selection horizontally.

Flip Vertical

Flips the current selection vertically.

Rotate 90 Degrees CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW

Rotates the current selection 90 degrees counterclockwise.
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Polyline Tool Properties
When you select the Polyline tool, its properties and options appear in the Tool Properties view.
NOTE
Like other shape tools, the Polyline tool creates pencil lines. Hence, its tool properties are similar to
the ones of the Pencil tool and it can be used with pencil presets.

Pencil Properties
Icon

Property

Description
The Preview area lets you see a preview of the stroke your drawing tool
will make.

Preview Area

Pencil Properties
Dialog

The arrow button right of the preview area opens the Pencil Properties
dialog.
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While the Tool Properties view only gives you access to the pencil size, a
list of pencil presets and other drawing options, the Pencil Properties
dialog gives you access to all the available options for your pencil's shape
and texture. For more information on the Pencil Properties dialog, see the
Polyline Tool Properties section below.
Size

Defines the width of the pencil line used to draw the shape.

Pencil Presets
Icon

Property

Description

Presets list

Harmony provides a variety of presets and also lets you create and save
your own. It is a good idea to create and save pencils with precise sizes
and parameters when you draw and design for efficiency and
consistency.
All tools using pencil lines share the same preset list. Therefore, the
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same preset
list.

New Preset

Creates a new preset based on the current brush properties.

Delete Preset

Deletes the currently selected preset.

Presets Menu

Gives access to more options for managing presets.

Rename Brush

Deletes the currently selected preset.

Import Brushes

Allows you to import brush presets exported from Harmony.

Export Brushes

Allows you to export your brush presets into an .xml file.

Small Thumbnail

Displays presets in a grid of small thumbnails with a preview of their tip.

Large Thumbnail

Displays presets in a grid of big thumbnails, with their name and a
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preview of their tip.

Stroke View

Displays presets in a list, with their name and a preview of a stroke done
with each preset. This is the default setting.

Drawing Options
Icon

Property

Description

Snap to Contour

Snaps your selection or point to any line you position it on. As soon as
you move it close enough to another line, your point or selection will snap
to it.
When enabled, drawing a closed shape will automatically fill it with the
currently selected Paint colour.

Auto Fill

TIP
By default the pencil line and its fill will be the same colour. If
you want to select different colours for the pencil line and its fill,
you can click on the Unlock Three Colours

button in the

Colour view, then select different colours for Brush strokes
, Pencil lines

and Paint fills

.

When enabled, drawing a closed shape will automatically remove the
outstanding lines.
Trim Extra Lines

Align Handles After
Trim

When the Trim Extra Lines option is enabled, enable this option to make
the point where the beginning and end of the stroke meet into a smooth
curve rather than a hard corner.
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As you draw in the Line Art layer, the Automatically Create Colour Art
option instantly creates the corresponding strokes in the Colour Art layer.
Automatically Create
Colour Art

By default, when drawing on a vector layer, each new stroke is created as
a separate drawing object, which can be edited independently from other
parts of the artwork. When enabled, the Auto-Flatten option
automatically merges strokes into existing artwork.

Auto-Flatten Mode

NOTE
Using the Select tool, you can use select and remove a segment
of flattened pencil lines. Overlapping pencil lines drawn with the
Auto-Flatten mode are essentially cut into segments by the
overlap and can be treated as individual lines.

Pencil Properties Dialog
The Polyline tool draws the same type of line as the Pencil tool. Hence, you can configure the Polyline tool's
lines using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke
display area in the Tool Properties view.
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Size and Smoothness Tab
The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the
shape of its tips and corners.

Tool Name

Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure
sensitive pen tablet, the width of the stroke will vary between its maximum size and
minimum size depending on the amount of pressure used. If used with a mouse, the
width of the stroke will always be its maximum size.

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you
do not have pressure sensitivity from a pen table, the minimum size value will be
ignored.

Smoothing

Defines the number of control points added to the centre line. The fewer the control
points the smoother (but less faithful) the line.

Contour Smoothing

Defines the number of points on the contour share of your stroke. This will smooth
out the bumps and waves on tour contour shape of your brush strokes.
You can adjust the start, end, and join style of a pencil line.

Shape

l

Start: Lets you select the style of the start tip, which is the first tip you drew.
You can choose between Round or Flat style.
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l

l

End: Lets you select the style of the end tip, which is the last tip you drew.
You can choose between Round or Flat style.
Join: Lets you select the joint style. The joints are where the line curves
abruptly. You could also define the Join style as the corner style. You can
choose between Round, Mitre and Bevel style.

Texture Tab
In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the current
pencil texture palette as the default one, or import the pencil texture palette into your scene.
The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the
Colour view—see Colour View on page 171.

Icon

Tool Name

Description

Use as Default Pencil
Texture Palette

Sets the currently selected pencil texture palette as the default pencil
texture palette in your user preferences. The default pencil texture palette
is added to every scene you create in Harmony. The palette is copied in
your preferences, so it will be added to your new scenes in the exact state
it is when you make it the default pencil texture palette.

Reload Default Texture
Palette

Imports the default pencil texture palette as a new pencil texture palette
into your scene's palette list, and selects it as the current pencil texture
palette.
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New Texture

Allows you to import an image file into a new pencil texture swatch in the
current pencil texture palette. The pencil texture's effect on your pencil line
will be based on the image's transparency channel, and will follow your
pencil lines on its horizontal axis.

Delete Texture

Deletes a pencil texture swatch from the current pencil texture palette.

Rename Texture

Renames the selected pencil texture swatch in the current pencil texture
palette.

Pencil Texture List

Displays the pencil textures in the current pencil texture palette and allows
you to select one to use with the Pencil tool.

Pencil Texture Palette

Displays the name of the currently selectedpencil texture palette, for
reference. To select a different pencil texture palette, you must select it in
the Colour view—see Colour View on page 171.
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Rectangle Tool Properties
When you select the Rectangle tool, its properties and options appear in the Tool Properties view. There are a
few less options available when working on a bitmap layer.

Icon

Tool Name

Description
The Preview area lets you see a preview of the stroke your drawing tool
will make.

Previewing the Stroke

Size

Defines the width of the pencil line used to draw the rectangle.
You can adjust the start, end, and join style of a pencil line.

Shape

l

Start: Lets you select the style of the start tip, which is the first tip
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you drew. You can choose between Round or Flat style.
l

l

End: Lets you select the style of the end tip, which is the last tip
you drew. You can choose between Round or Flat style.
Join: Lets you select the joint style. The joints are where the line
curves abruptly. You could also define the Join style as the corner
style. You can choose between Round, Mitre and Bevel style.

Harmony provides a variety of presets and also lets you create and save
your own. It is a good idea to create and save pencils with precise sizes
Presets

and parameters when you draw and design for efficiency and
consistency.
All tools using pencil lines share the same preset list. Therefore, the
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same preset
list.

New Brush

Creates a new preset based on the current brush properties.

Delete Brush

Deletes the currently selected preset.

Rename Brush

Deletes the currently selected preset.

Import Brushes

Allows you to import brush presets exported from Harmony.

Export Brushes

Allows you to export your brush presets into an .xml file.

Small Thumbnail, Large
Thumbnail, and Stroke
View

Allows you to display the presets as small square thumbnails, large
square thumbnails or a list of stroke preview.

When enabled, your brush strokes will appear behind the existing
artwork. Note that they will appear over your artwork while drawing your
stroke, until you release the brush.
Draw Behind

Automatic Filling

Use the Automatic Filling option to automatically fill your shape with the
selected colour as you draw. By default, the Shape tool creates the outline
of an empty shape that you can later fill using the Paint tool. This option
is unavailable for the line tool.
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Snap to Contour

Snaps your selection or point to any line you position it on. As soon as
you move it close enough to another line, your point or selection will snap
to it.

Snap and Align

Snaps the selected anchor point to any existing line while displaying
temporary rulers as a guide that you can also snap your anchor point to.
Snaps your selection following the currently enabled grid.

Snap to Grid

As you draw in the Line Art layer, the Automatically Create Colour Art
option instantly creates the corresponding strokes in the Colour Art layer.
Automatically Create
Colour Art

By default, when drawing on a vector layer, each new stroke is created as
a separate drawing object, which can be edited independently from other
parts of the artwork. When enabled, the Auto-Flatten option
automatically merges strokes into existing artwork.
Auto-Flatten Mode
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NOTE
Using the Select tool, you can use select and remove a segment
of flattened pencil lines. Overlapping pencil lines drawn with the
Auto-Flatten mode are essentially cut into segments by the
overlap and can be treated as individual lines.

Use Stored Colour
Gradient

The Use Stored Colour Gradient option can be used when painting with a
gradient colour to always position the gradient in the same way it was
stored, making it consistent across brush strokes. You can store a
gradient by selecting a zone painted with a gradient with the Select tool,
then clicking on Store Colour Gradient

Draw Square

in the Tool Properties view.

Enable this option to draw perfect square (ratio 1:1) without holding any
keyboard shortcuts. As an alternative, you can hold down the Shift key.

Pencil Properties Dialog
The Rectangle tool draws the same type of line as the Pencil tool. Hence, you can configure the Rectangle tool's
lines using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke
display area in the Tool Properties view.

Size and Smoothness Tab
The Size and Smoothness tab allows you to select your pencil's size, its smoothing parameters as well as the
shape of its tips and corners.
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Tool Name

Description

Maximum Size

Defines the maximum size of the pencil line. If the tool is used with a pressure
sensitive pen tablet, the width of the stroke will vary between its maximum size and
minimum size depending on the amount of pressure used. If used with a mouse, the
width of the stroke will always be its maximum size.

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you
do not have pressure sensitivity from a pen table, the minimum size value will be
ignored.

Smoothing

Defines the number of control points added to the centre line. The fewer the control
points the smoother (but less faithful) the line.

Contour Smoothing

Defines the number of points on the contour share of your stroke. This will smooth
out the bumps and waves on tour contour shape of your brush strokes.
You can adjust the start, end, and join style of a pencil line.

Shape

l

l

l

Start: Lets you select the style of the start tip, which is the first tip you drew.
You can choose between Round or Flat style.
End: Lets you select the style of the end tip, which is the last tip you drew.
You can choose between Round or Flat style.
Join: Lets you select the joint style. The joints are where the line curves
abruptly. You could also define the Join style as the corner style. You can
choose between Round, Mitre and Bevel style.

Texture Tab
In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected
pencil texture palette to use with the Pencil tool. You can also add, remove or rename textures, save the current
pencil texture palette as the default one, or import the pencil texture palette into your scene.
The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the
Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the
Colour view—see Colour View on page 171.
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Icon

Tool Name

Use as Default Pencil
Texture Palette

Description
Sets the currently selected pencil texture palette as the default pencil
texture palette in your user preferences. The default pencil texture palette
is added to every scene you create in Harmony. The palette is copied in
your preferences, so it will be added to your new scenes in the exact state
it is when you make it the default pencil texture palette.

Reload Default Texture
Palette

Imports the default pencil texture palette as a new pencil texture palette
into your scene's palette list, and selects it as the current pencil texture
palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in the
current pencil texture palette. The pencil texture's effect on your pencil line
will be based on the image's transparency channel, and will follow your
pencil lines on its horizontal axis.

Delete Texture

Deletes a pencil texture swatch from the current pencil texture palette.

Rename Texture

Renames the selected pencil texture swatch in the current pencil texture
palette.

Pencil Texture List

Displays the pencil textures in the current pencil texture palette and allows
you to select one to use with the Pencil tool.

Pencil Texture Palette

Displays the name of the currently selectedpencil texture palette, for
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reference. To select a different pencil texture palette, you must select it in
the Colour view—see Colour View on page 171.
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Reposition All Drawings Tool Properties
When you use the Reposition All Drawings tool, its properties and options appear in the Tool Properties view.

Icon

Option

Description

Flip Horizontal

Flips the current selection horizontally.

Flip Vertical

Flips the current selection vertically.

Rotate 90 Degrees CW

Rotates the current selection 90 degrees
clockwise.

Rotate 90 Degrees CCW

Rotates the current selection 90 degrees
counter-clockwise.
Use the Offset X and Offset Y operation fields
to enter specific values and precisely
reposition the selected shape.

Offset X and Y
1. X: Type a value in this field to
reposition your selection along the Xaxis.
2. Y: Type a value in this field to
reposition your selection along the Y-
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axis.
3. Up/Down arrows: Use the up and
down arrows to modify the value in the
X or Y value field.
Use the Width and Height operation fields to
enter specific values to resize the selected
shape with precision.

1. Width: Type a value in this field to
resize the width of your selection.

Width and Height

2. Height: Type a value in this field to
resize the height of your selection.
3. Up/Down arrows: Use the up and
down arrows to modify the value in the
Width or Height fields.
4. Lock icon: Click the lock icon to lock or
unlock the ratio between the Width
and Height values.
The Angle operation lets you to enter specific
values and accurately rotate the selected
shape.

Angle

1. Angle: Type a degree value in this field
to rotate your selection.
2. Up/Down arrows: Use the up and
down arrows to modify the value in the
Angle value field.
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Select Tool Properties
When you use the Select tool, its properties and options appear in the Tool Properties view.

Tool Options
Icon

Tool Name

Description
Sets the selection mode to Lasso, which allows you to
select multiple items by drawing a lasso around them.

TIP

Lasso

When this option is enabled, you can press
and hold the Alt key to temporarily use
Marquee mode.

Sets the selection mode to Marquee, which allows you
to select multiple items by drawing a rectangle around
them.

Marquee
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TIP
When this option is enabled, you can press
and hold the Alt key to temporarily use
Lasso mode.

Snap to Contour

Snaps your selection or point to any line you position
it on. As soon as you move it close enough to another
line, your point or selection will snap to it.

Snap and Align

Snaps the selected anchor point to any existing line
while displaying temporary rulers as a guide that you
can also snap your anchor point to.
Snaps your selection following the currently enabled
grid.

Snap to Grid

Lets you select all the zones and lines in your drawing
painted with the same colour swatch.

Select by Colour

In the Drawing view, click on any zone or line in your
drawing. All zones and lines of the same colour are
selected. Click the Select tool again to return to the
regular Select mode.
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NOTE
Only the zones painted with the SAME
colour swatch will be selected. If another
zone is coloured with the exact same RGB
value (same colour), but not painted with the
same colour swatch, it will not be selected.

Lets you maintain a selection over multiple drawings.
Once this option is enabled, the selection zone made
using the Select tool will remain as you navigate
through drawings of the same layer and drawings
from other drawing layers. This option can be used to
simultaneously delete artwork inside or outside of the
selection on several drawings when combined with
the Apply to Multiple Drawings option.
Permanent Selection

The Apply to Multiple Drawings option is used to
perform an action on all the drawings contained in a
layer. With the Select tool, this option can be used to
select and remove vector shapes on all the drawings
contained in a layer. To use it, activate Permanent
Selection option and make a selection that can be
applied to all your drawings. Then, activate the Apply
to Multiple Drawings option and press delete. This will
delete all the shapes that would have been selected by
the permanent selection on every drawing in the layer.
This can be used for example to remove dirt and
registration on the same areas of all the drawings
simultaneously on a layer.

Apply to Multiple Drawings

The Apply to Multiple Drawings option disables itself
after each action.
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Allows you to perform drawing operations on both the
Line Art and Colour Art layers of your drawing
simultaneously.
Apply to Line and Colour Art

NOTE
If you have Overlay and Underlay Art layers
enabled, they will also be affected when this
option is enabled.

Operations
Icon

Tool Name

Description

Flip Horizontal

Flips the current selection horizontally.

Flip Vertical

Flips the current selection vertically.

Rotate 90 Degrees CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW

Rotates the current selection 90 degrees counterclockwise.
Smooth out selected drawing strokes and remove
extra points.

Smooth
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Merges drawing objects and brush strokes into a
single layer. If you draw new lines to fix a drawing or
line with many brush strokes, it can be useful to flatten
them all into a single shape. By default, lines are drawn
one on top of each other. If you intend to repaint the
lines or modify their shape, it will be easier if they are
flattened.
Flatten

Lets you use the outline you traced on one of the four
embedded layers (line art, colour art, overlay, underlay)
and create invisible strokes to paint your drawings on
separate layers. This provides more inking and
painting flexibility.

Create Colour Art from
Line Art

You can also configure this option to create the
invisible strokes on any of the four embedded layers.
Use the Store Colour Gradient operation to record the
selected gradient’s position. This reuses the stored
position of the gradient when drawing new brush
lines or painting colour zones. Enable the Use Stored

Store Colour Gradient

Colour Gradient

option in the Paint or Brush Tool

Properties view to do this.
Converts the selected centre line pencil strokes into
contour strokes brush lines.

Pencil to Brush

Pencil lines are central vector lines and it might be
difficult to match pencil line’s tips properly to align
them and make it look like it is one single line. With

Merge Pencil Lines
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the Select tool, you can select several pencil lines and
merge them as one single object using the Merge
Pencil Lines option. The ends of your lines are
adjusted to form one single line.

NOTE
Points must be close enough to be merged. If
there is a large gap between the lines, they
will not be merged.

The Reverse Pencil Thickness option inverts the thick
and thin section on a selected pencil line. This option
will take the thickest size on the line and apply it to the
thinnest, and it will apply the thinnest to the thickest.

Reverse Pencil Thickness

Use the Offset X and Offset Y operation fields to enter
specific values and precisely reposition the selected
shape.

Offset X and Y
1. X: Type a value in this field to reposition your
selection along the X-axis.
2. Y: Type a value in this field to reposition your
selection along the Y-axis.
3. Up/Down arrows: Use the up and down
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arrows to modify the value in the X or Y value
field.
Use the Width and Height operation fields to enter
specific values to resize the selected shape with
precision.

1. Width: Type a value in this field to resize the
width of your selection.

Width and Height

2. Height: Type a value in this field to resize the
height of your selection.
3. Up/Down arrows: Use the up and down
arrows to modify the value in the Width or
Height fields.
4. Lock icon: Click the lock icon to lock or unlock
the ratio between the Width and Height values.
The Angle operation lets you to enter specific values
and accurately rotate the selected shape.

Angle

1. Angle: Type a degree value in this field to
rotate your selection.
2. Up/Down arrows: Use the up and down
arrows to modify the value in the Angle value
field.
When you select a pencil line with the Select tool,
additional options appear in the Tool Properties view.

Adjusting the Pencil Line
Thickness

Use the Adjusting the Pencil Line Thickness operation
field to resize the selected centreline strokes. This
operation is not permitted on contour line shapes,
such as brush strokes or shape fills.
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1. Minimum Size: Type a value in this field to set
the minimum thickness of the selected
centreline stroke.
2. Maximum Size: Type a value in this field to set
the maximum thickness of the selected
centreline stroke.
3. Up/Down arrows: Use the up and down
arrows to modify the value contained in the
Thickness value field.
You can adjust the start, end, and join style of a pencil
line.

l

Pencil Line Shape
l

l

Start: Lets you select the style of the start tip,
which is the first tip you drew. You can choose
between Round or Flat style.
End: Lets you select the style of the end tip,
which is the last tip you drew. You can choose
between Round or Flat style.
Join: Lets you select the joint style. The joints
are where the line curves abruptly. You could
also define the Join style as the corner style.
You can choose between Round, Mitre and
Bevel style.

Gives you the flexibility to change the style and
thickness of your pencil lines even after they are
drawn. You can apply preset pencil stencils or create
your own.

Pencil Stencils
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Pencil lines support texture. Once a pencil line is
drawn, you can apply a preset texture or load your
own. Textures are independent from pencil stencils.

Adding Texture to a
Pencil Line

When you select text with the Select tool, the tool
properties will display the Text tool options on the
bottom of the view. You can also press Alt + 9 to
display only the Text properties in the Tool Properties
view—see Text Tool Properties on page 153.
Adjusting the Text
Selection
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Smooth Editor Tool Properties
When you select the Smooth Editor tool, its properties and options appear in the Tool Properties view.

Icon

Tool Name

Description
The Smoothing Style options allow you to smooth a
portion of your drawing by tracing a smoothing stroke
over the zone to optimize or by selecting an area of
the drawing with the Marquee or Lasso.
Note that by default, the Smooth Editor tool colour is
yellow, it was changed to orange for screen grab
clarity.

Smoothing Style

The Show Control Points option allows you to show
or hide the Bezier points around lines. When the
Bezier points are displayed, you can see the result of
your smoothing and the number of points left on the
curve. When it is turned off, only the original artwork
is displayed.

Show Control Points

This is where you set the minimum and maximum
sizes of your drawing tool which will produce the
thick and thin effect on your stroke. This works with
the pressure sensitivity of a pen tablet.

Minimum Size and
Maximum Size

This options is available while using the Brush
Smoothing
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l

l

Maximum and Minimum Size: Defines the
maximum and minimum width of the stroke.
Up/Down arrows: Use the up and down
arrows to set the minimum and maximum size
value.

The Smoothness impacts the strength of the
smoothing result. The higher the value, the more
points are removed and the smoother the curve. The
Smoothness range is from 0 to 100; the default value
is 20.

Smoothness

You can modify the colour of the control points
displayed on the artwork while working with the
Smooth Editor tool by double-clicking on the colour
swatch.

Colour
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Stroke Tool Properties
When you select the Stroke tool, its properties and options appears in the Tool Properties view.

Icon

Tool Name

Description

Draw Stroke as
Straight Lines

Enable the Draw Stroke as Straight Lines option if you want the new strokes
you draw to be a perfect straight line. Disable the option if you want the
stroke to follow the mouse gesture.

Connect Line Ends

Enable the Connect Line Ends option if you want the start or end point of
your new stroke to connect to your existing strokes to make sure no gaps are
left in your drawing.
When enabled, drawing a closed shape will automatically fill it with the
currently selected Paint colour.

Auto Fill

TIP
By default the pencil line and its fill will be the same colour. If you
want to select different colours for the pencil line and its fill, you can
click on the Unlock Three Colours

button in the Colour view, then

select different colours for Brush strokes
Paint fills

Trim Extra Lines

, Pencil lines

and

.

When enabled, drawing a closed shape will automatically remove the
outstanding lines.
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When the Trim Extra Lines option is enabled, enable this option to make the
point where the beginning and end of the stroke meet into a smooth curve
rather than a hard corner.

Align Handles After
Trim

Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as a
separate drawing object, which can be edited independently from other parts
of the artwork. When enabled, the Auto-Flatten option automatically merges
strokes into existing artwork.
Allows you to perform drawing operations on both the Line Art and Colour
Art layers of your drawing simultaneously.

Apply to Line and
Colour Art

NOTE
If you have Overlay and Underlay Art layers enabled, they will also
be affected when this option is enabled.

Apply to Synced
Drawing Layers

When working on a synced layer, the tool is applied to the current layer and
all the layers that are synced to it. This option only works in the Camera view.

Smoothness

You can modify the central line smoothness of your line using this option.
This parameter smooths the initial movement of your line. Increasing the
value will result in a smoother line with fewer control points. Use the left and
right arrows to increment the value by one full unit. Use the Up - Down slider
to quickly increment the value.
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Text Tool Properties
Use the Text tool's properties to select the font type and other formatting options you want to apply to the
text.
If you already wrote your text, you must first use the Text tool and select the text portion you want to format.
You can modify the parameters of an entire text box using the Select tool.

Icon

Tool Name

Description
Use the Font drop-down menu to select a font. OTF fonts are supported.

Font Type

Use this option to bold your text selection.
Bold

Use this option to italicize your text selection.
Italic

Left Alignment

Use this option to left align the paragraph.
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Use this option to center align the paragraph.

Centered
Alignment

Use this option to right align the paragraph.

Right Alignment

Use this option to justify align the paragraph.

Justified
Alignment

Enter a size for the text.
Font Size

Kerning

Use the kerning field to modify the spacing between letters and characters. You
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can select the Auto Kern option to set the kerning automatically based on the
font’s predefined standard. A negative value decreases spacing between each
character, creating a letter overlap and a positive value increases it.

Enter a value in the Indent field to increase or decrease the indentation on the first
line of your text. A positive value sets the first line of your paragraph farther to the
right and a negative value sets it farther to the left.
Indent

Enter a value in the Line Spacing field to decrease or increase the space between
each line of text.

Line Spacing
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Zoom Tool Properties
When you select the Zoom tool, its properties are displayed in the Tool Properties view.

Tool Options
Icon

Parameter

Description

Zoom In Mode

Use the mouse cursor to zoom in to the Camera or Drawing view.

Zoom Out
Mode

Use the mouse cursor to zoom out of the Camera or Drawing view.

Operations
Icon

Parameter

Description

Perform Zoom
In

Zoom in the Camera or Drawing view.

Perform Zoom
Out

Zoom out the Camera or Drawing view.

Reset Zoom

Restores the current zoom level to 100%.

Reset View

Restores the original display by resetting any pan, rotation or zoom actions.

The keyboard shortcut is 2.

The keyboard shortcut is 1.
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Chapter 3: Toolbars
Harmony contains toolbars which, by default, are located at the top of the interface. Some views also have a
toolbar which you can reposition to suit your work style. You can show or hide toolbars, as well as customize it
with the tools you use most often and hide the ones you don't.
Top Toolbars

159

Edit Toolbar

160

File Toolbar

161

Tool Presets Toolbar

162

Tools Toolbar

163

Workspace Toolbar

168

View Toolbars

169
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Top Toolbars
Harmony has a series of toolbars that are added by default at the top of the interface. These toolbars can be
moved on the sides of the interface as well as within specific views.
All top toolbars can be added through the top menu Windows > Toolbars > desired toolbar.
Edit Toolbar

160

File Toolbar

161

Tool Presets Toolbar

162

Tools Toolbar

163

Workspace Toolbar

168
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Edit Toolbar
The Edit toolbar contains common operations such as Copy, Paste, Cut, Undo and Redo. These options can also
be found in the Edit menu.

How to access the Edit toolbar
1. Select Windows > Toolbars > Edit.

Icon

Tool Name

Description

Undo

Removes the last change made to your project.
Harmony supports multiple undo, so you can undo
changes you made in the order you made them.

Redo

Redoes an operation you have undone. This command
is active only after you use the Undo command.

Cut

Removes selected objects. You can then paste the
object or its properties to another object.

Copy

Copies selected objects and properties.

Paste

Places an object you cut or copied into the location
you select in a view.

Create Symbol

Creates a symbol from selected drawing elements in
the Drawing or Camera view or a layer or cells in the
Timeline view.
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File Toolbar
The File toolbar contains the common file operations such as New, Save and Open. These options can also be
found in the File menu.

How to access the File toolbar
1. Select Windows > Toolbars > File.

Icon

Tool Name

Description

Open

Displays the Open Scene dialog box where you can browse for a scene
file. You can open a new scene from the current one and the previous
scene will close.

Save

Saves all changes made to the opened scene, drawings, palettes, and
palette lists.

Load Background File

Allows you to select an image to temporarily add as a background to
your drawings, for reference. This background will not be in the scene.
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Tool Presets Toolbar
The Tool Presets toolbar lets you create new tool presets and manage them.

How to access the Tool Presets toolbar
1. Select Windows > Toolbars > Tool Presets.

Icon

Tool Name

Description

New Tool Preset

Creates a new tool preset from the current tool
settings.

Manage Presets

Opens the Manage Tool Preset dialog box where you
can update, organize, and delete existing presets.
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Tools Toolbar
The Tools toolbar contains all the main tools you need to work in Harmony. In the default workspace, this
toolbar located on the left-most side of the interface. A small triangle at the lower-right corner of a tool
indicates additional tools under the main tool. To access these tools, hold down the left mouse button until the
additional tools appear, then select one.
By default, the Tools toolbar displays several of its tools in pop-up menus that must be opened. It is possible to
make the Tools toolbar display every tool in its individual button instead by enabling the Flat Tools Toolbar
preference. This makes the selection of tools quicker. However, because there is not enough vertical space to
display all tools, some tools will be hidden from the Tools toolbar by default. Which tools are displayed in the
Tools toolbar when Flat Tools Toolbar is enabled can be customized. The order in which tools are listed in Flat
Tools Toolbar mode can also be customized.

How to make every tool in the Tools toolbar display in buttons rather than pop-up
menus
1. Do one of the following:
l

Select Edit > Preferences (Windows/Linux) or Harmony [Edition] > Preferences
(macOS).

l

Press Ctrl + U (Windows/Linux) or ⌘ + U (macOS).

2. Select the General tab.
3. In the Options section, select the Flat Tool Toolbar option.

4. Click OK and restart Harmony.

How to customize which tools are displayed in the Tools toolbar when it is in Flat mode
1. Right-click on the Tools toolbar and select Customize.
The Toolbar Manager dialog appears.
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2. In the Available Tools list, select each tool that you want to add to the Tools toolbar, then click on
the Add the selected tool to the toolbar

button.

3. In the Toolbar list, select each tool that you want to remove from the Tools toolbar, then click on the
Remove the selected tool from the toolbar

Tool Name

Icon

button.

Description
Allows you to select and reposition, scale, rotate and skew brush strokes,

Select

pencil lines, shapes and other parts of your artwork.

Cutter

Allows you to cut a part of your artwork, then reposition, scale, rotate
and skew it.

Reposition All
Drawings

Allows you to reposition, scale, rotate and skew all drawings in the
current layer.

Contour Editor

Allows you to edit the vector contours of brush strokes, pencil lines and
shapes in your artwork. You can add, remove, tweak and move vector
points, move the Bezier handles of the vector points as well as deform
vector outlines.

Centerline Editor

Allows you to tweak and deform a brush stroke by manipulating the
points at the centre of its line rather than its contour.

Pencil Editor

Allows you to adjust the thickness of a pencil line at its different points
and corners, tweak the shape of its extremities and scale its texture.
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Smooth Editor

Allows you to optimize contours and lines by removing its extra points,
making them easier to edit.

Perspective

Allows you to deform artwork by applying a perspective effect on it.

Envelope

Allows you to deform and warp artwork by moving points and tweaking
lines in a grid.

Edit
Gradient/Texture

Allows you to adjust the position, angle and size of gradients and
textures in a colour zone.

Brush

A pressure-sensitive tool for creating a contour shape with a thick and
thin line effect, as if created with a paint brush.

Pencil

A pressure-sensitive tool for drawing outlines. Pencil lines are made of
central vector lines, making them easier to tweak and edit than brush
strokes.

Text

Allows you to add text and to format it.

Eraser

A pressure-sensitive tool for erasing parts of a drawing.

Paint

Allows you to fill colour zones with a colour or texture.

Ink

Allows you to recolour pencil lines with precision by changing the colour
of one segment at a time.

Paint Unpainted

Allows you to quickly fill empty zones in your artwork with a colour or
texture, leaving filled zones unchanged.

Repaint

Allows you to quickly repaint painted zones in your artwork. Empty
zones will remain empty.

Unpaint

Allows you to empty filled colour zones of their colour and texture.

Stroke

Allows you to create invisible lines that can serve as colour zones that
can be filled, or close the gaps in existing colour zones.
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Close Gap

Line

Allows you to close open shapes so that they can be filled with the Paint
tool. By drawing a stroke near a small gap in a shape, this tool will create
a small invisible stroke connecting the two closest points around the gap.

Draws a straight line segment going from one point to the other.

Rectangle

Draws a rectangle.

Ellipse

Draws an ellipse.

Polyline

Allows you to draw shapes, segmented lines or complex curved lines by
clicking to create each point in the sequence of line segments.

Dropper

Allows you to select a colour by clicking on a colour in your artwork.

Drawing Pivot

Allows you to position the pivot on a drawing layer by clicking where you
want its location to be.

Morphing

Allows you to create and configure a morphing sequence, which will
automatically generate the in-betweens between two drawings in the
current layer.

Hand

Allows you to pan the Camera and Drawing views.

Zoom

Allows you zoom in and out of the Camera and Drawing views.

Rotate View

Lets you rotate the Camera and Drawing views just like with a real
animation disc.

Animate Mode

Enables the Animate mode which records the position, rotation, scale,
skew, etc. of objects as keyframes in the Timeline view. Turn off the
Animate mode to reposition objects for the entire scene. When the
Animate mode is disabled, keyframes are not created when an object's
parameters change.

Transform

Allows you to select drawing layers and position, rotate, scale and skew
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them.

Onion Skin

Displays the previous and next frames of an animation. Useful when
animating cut-out characters.
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Workspace Toolbar
The Workspace toolbar lets you load other workspaces. The first time you start Harmony, the default
workspace is loaded. Other workspaces are available such as the Hand-Drawn Animation and Compositing
workspaces; these display different views and toolbars. You can access these workspaces and any you create,
from the Windows menu and the Workspace toolbar.

How to access the Workspace toolbar
1. Select Windows > Toolbars > Workspace.

Icon

Tool Name

Description

Workspace List

Allows you to select an existing workspace.

Workspace Manager

Opens the Workspace Manager where you can
organize, display, and remove workspace from your
list.

Save Workspace

When the Automatically Save Workspace preference
is disabled, the Save Workspace button becomes
available. This allows you to manually save your new
workspace configuration.
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View Toolbars
Harmony has a series of view specific toolbars that are only available in a given view. These toolbars can be
moved only within their view.
All view toolbars can be added, as long as the view is visible, through the top menu Windows > Toolbars >
desired toolbar.
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Chapter 4: Views
The Harmony interface is composed of different views, each one designed for a specific purpose. You can modify
the location of the views by adding a new view as a tab or as a window. You can also swap the location of a
view.
When a view is active, a red rectangle appears around the view. Keyboard shortcuts and top menu options are
associated with the active view. If a menu option is greyed out, it means it does not apply to the layer, drawing
or other type of selection or the option does not apply to the active view.
Colour View
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Drawing View

178

Integrated Help View

181

Message Log View

182

Model View

183

Tool Properties View
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Colour View
The Colour view is where you create colours and palettes and import existing palettes into your project. The
Colour view is also necessary for drawing, painting and creating colour styling.

How to access the Colour view
Do one of the following:
l

From the top menu, select Windows > Colour.

l

From any of the other views, click the Add View

button and select Colour.

Palette List Panel
Icon

Option

Description

View Menu

The View menu contains all the commands and options that you can
use in the Colour view to manage colours and palettes.
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Collapse/Expand Palette
List

Allows you to show or hide your palette list and its options. By default,
the palette list is displayed, but you may want to hide it if you are
working with a single palette and want to allow more vertical space for
the colour swatch list.

Add Palette

Allows you to create a new palette.

Deletes the currently selected palette. If the colour swatch is used in
your project, zones painted with colour swatches which have been
deleted will turn red, easily identifying them so you can repaint them
with another colour swatch.

Remove Palette

Link Palette

Allows you to add a palette from a different location, be it in a scene,
job, environment or even an element to your palette list. The palette will
be linked to its original location rather than copied to your scene's
folder. Hence, if you make changes to the original palette, it will affect
the colour of elements in your scene.
If you want to import a palette as a copy into your scene's palette library,
right-click on your palette list and select Import. You can also link to a
palette in any location on your machine or network by selecting Link
to External.
Moves palettes further up or down the palette list.

Order Palette List

Edit Palette List Mode
Indicator

If a palette has been cloned, the highest palette among the original
palette and its clone(s) will be used by Harmony.
In Harmony Server, this icon appears when you have the modifying
rights on your scene's palette list. While several users can work on a
scene at the same time, only one user may have the right to modify a
palette list at any given time.
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NOTE
In Harmony Stand Alone, you can always modify your scene's
palette list. On Harmony Server, you must unlock your palette
list before making modifications to it.

Show Colour Palettes

Shows only colour palettes in the palette list. This is the default option.

Show
Pencil Texture Palettes

Shows only pencil texture palettes in the palette list.

Show All Palettes

Shows both colour and pencil texture palettes in the palette list.

Palette List
Icon

Description

In Harmony Server, this indicates that you have the rights to modify the palette.

Indicates that the palette is stored at the same level as its palette list. For example, a palette that is stored
in the scene's palette library and which is listed in the scene's palette list, or a palette that is stored in an
element's palette library and which is listed in that same element's palette list.
Indicates that the palette file is stored in an external location, such as a different scene, an element in a
different scene, a job other than the scene's job, or an environment other than the scene's environment.
This means the palette is liable to be missing if it is moved from its original location, or if the scene is
exported from the database into an offline scene or to a different database.
This indicates that the palette is stored at a higher level than its palette list, making it a shared palette. For
example, a palette in your scene's palette list that is stored in the palette library of the scene's job or
environment, or a palette in an element's palette list that is stored in the palette library of the scene.
Indicates a potentially dangerous situation. For example, a palette file that is stored in one of the scene's
element folders, but which is added to your scene's palette list. The whole scene can use the palette, but
since it's stored inside an element, deleting that element will make your whole scene lose access to that
palette.
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Navigation Panel
Icon

Option

Description

Previous Drawing

Navigates to the previous drawing in the loaded drawings list.

Next Drawing

Navigates to the next drawing in the loaded drawings list.

Previous Column

Switches to the previous column in the loaded columns.

Next Column

Switches to the next column in the loaded columns.

Line Art

View and edit the drawing's line art layer.

Colour Art

View and edit the drawing's colour art layer.

Preview Line Art and Colour Art

If enabled, both the drawing's line art and colour art layers will be
visible. If disabled, only the art layer you are currently working on
will be visible.

Colour Swatch List Panel
Icon

Option

Description

Add Colour

Adds a new colour swatch to the bottom of your colour list.

Remove Colour

The Remove Colour button lets you delete the currently selected
colour swatches. If the colour swatch is used in your project, and
confirmation dialog will appear prompting you to confirm that you
want to delete the colour. Zones painted with colour swatches which
have been deleted will turn red, easily identifying them so you can
repaint them with another colour swatch.
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Allows you to import a bitmap image as a texture, which can be
painted with just like a colour. When used with the Brush or Paint
tools, bitmap textures are tiled inside the shape they fill. The scaling
and position of the texture inside their shape can be tweaked with the
Edit Gradient/Texture tool. When used with the Pencil tool or one of
the Shape tools, a bitmap texture will follow the pencil line's
direction.

Add Texture

Set Current Brush Colour

When enabled, the colour you select in the colour view will be
selected for the Brush tool.

Set Current Pencil Colour

When enabled, the colour you select in the colour view will be
selected for the Pencil tool, as well as other tools that create pencil
lines, such as the Line, Rectangle, Ellipse and Polyline tools.

Set Current Paint Colour

When enabled, the colour you select in the colour view will be
selected for the Paint tool.
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When enabled, the colour you select will be selected for all drawing
tools. When disabled, you can select individual colours for the Brush,
Pencil and Paint tools.

Link/Unlink Three Colours

In Harmony Server, this allows you to get the modifying rights to the
selected palettes.

Edit Palette Mode

Since several people can work on any given scene at the same time,
and a palette can be shared between scenes, palettes may be loaded
in read-only mode when opening a scene on a Harmony database.
Then, an user would only be able to edit a palette by first activating
Edit Palette Mode. This prevents several users from making changes
on the palette at the same time, since a user cannot activate Edit
Palette Mode on a palette that is already being edited by someone
else. This also prevents users from accidentally making modifications
on important palettes.
In Harmony Server, this icon appears when you have the modifying
rights on the currently selected palette.

Edit Palette Mode Indicator

NOTE
In Harmony Stand Alone, you can always modify your
palettes.

Each colour swatch available in the Colour view can have its own
name, making it easy to identify which colour is used to paint what
part of your character or background.

Colour Swatch Name

NOTE
Two colours can have the same name. Harmony identifies
colours by an identification number.
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Also referred to as colour pots, the colour swatch is the actual colour
information for a colour in your palette. It is represented by a
rectangle displaying the colour in the list.
Colour Swatch
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Drawing View
Only the selected drawing is displayed by default in the Drawing view. You can use features, such as the light
table to display the current drawing of all the enabled layers of your scene in washed-out colours, or the Onion
Skin to display the previous and next drawings of the currently selected drawing layer.

How to access the Drawing view
Do one of the following:
l

From the top menu, select Windows > Drawing .

l

From any of the other views, click the Add View

Icon

button and select Drawing.

Section

Description

View Menu

The View menu contains all the tools and options that
you can use in the Drawing view to draw, animate and
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paint.
This is the main space in the Drawing view. It is where
you draw and where the drawings are displayed.

Drawing Area

The Zoom menu lets you enlarge or reduce the Camera
or Drawing view display.
To make the camera frame size always match the size
of your view, select the Fit to View option. Click the
drop-down arrow and select a zoom level or press 1
and 2.

Zoom Menu

Drawing Name

The Drawing Name field displays the name of the
selected drawing, as well as the layer containing it. If
the cell does not contain any drawing, an Empty
Cell text is shown in the field.

Tool Name

The Tool Name field displays the name of the selected
tool. If you temporarily override a drawing tool using a
keyboard shortcut, the tool’s name will be highlighted
in red. You can temporarily override a tool by holding
its keyboard shortcut without the Alt key. For
example, the Select tool shortcut is Alt + S. If you hold
down the S key, you will switch to the Select tool.
When you release the key, you will return to the tool
you were using.

Frame Number

This field displays the current frame of the animation
you are working on.

Cursor Coordinates

This indicates the position of the your pointer in the
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drawing area.
The Colour Picker allows you to select a colour for
drawing.

Colour Picker

The Drawing Thumbnails panel displays a list with
thumbnails of the loaded drawings. The highlighted
drawing is the one displayed in the drawing area. You
can select the drawing you want to paint directly from

Drawing Thumbnails
Panel

this list.
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Integrated Help View
Use the Integrated Help when you are unsure about what a certain menu item is or the function of a specific
preference in the Preferences panel.
If you keep the Integrated Help window open for the entire duration of your work session, then you can use the
forward and backward arrows to scroll through a history of the help information that you called up during your
session.

How to access the Integrated Help view
1. Do one of the following:
l

From the top menu, select Windows > Integrated Help.

l

From any of the other views, click the Add View
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button and select Integrated Help.
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Message Log View
The Message log view displays information gathered during a render task, such as which frames and at what
time they were each rendered. The view also contains a list of the colour recovery operations.

How to access the Message Log view
Do one of the following:
l

From the top menu, select Windows > Message Log.

l

From any of the other views, click the Add View
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button and select Message Log.

Harmony 15.0 Paint Reference Guide

Model View
T-ANIMPA-004-004
Once you have a fully painted drawing, you can use it as a colour model and load it in the Model view. This
drawing can be used and loaded in any of your Harmony scenes.
Once a drawing is loaded in the Model view, you can use the Dropper

tool to select a colour from the model

and use it to paint in the Camera or Drawing view without having to pick the colour from the colour palette.

How to access the Model view
Do one of the following:
l

From the top menu, select Windows > Model.

l

From any of the other views, click the Add View

Icon

button and select Model.

Section

Description

View Menu

The View menu contains all the tools and options that
you can use to manage models.

Model View Toolbar

The Model View toolbar contains all the tools and
options you can use in the Model view to navigate
through and manage models.
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Tool Properties View
T-HFND-004-002
The Tool Properties view contains the most common options and operations related to the currently selected
tool. When you select a tool from the Tools toolbar, the Tool Properties view updates.
For example, if you choose the Select tool, the Tool Properties view will display the options and operations
related to it, such as Snap to Contour, Apply to All Drawings, Flip Horizontal, and Flatten.

NOTE
To learn more about the options appearing in the Tool Properties view, see Tools Properties on
page 32.

How to access the Tool Properties view
Do one of the following:
l

From the top menu, select Windows > Tool Properties.

l

From any of the other views, click the Add View
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button and select Tool Properties.

